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Abstract

This thesis addresses the problem of identifying the modal properties of structures using vibration 
measurements. Modal identification methodologies are proposed based on vibration 
measurements induced by artificial, ambient or earthquake loads applied on the structure. A 
modal model of the structure is identified using a weighted least-squares approach and measured 
time histories at selected locations of a structure. For artificially induced and ambient vibration 
measurements, the identification is performed in the frequency domain using respectively 
frequency response functions and cross power spectral densities. For earthquake induced 
vibrations, the identification is performed in both time and frequency domains. The modal 
identification methods presented in this work treat generalized non-classically damped modal 
models.

The identification of the modal parameter (modal frequencies, modal damping ratios, modeshape 
components and modal participation factors) is accomplished by introducing a computationally 
very efficient three step approach as follows. In the first step, stabilization diagrams are 
constructed containing frequency and damping information. The modeshape components and 
participation factors are estimated in a second least-squares step, based on the user selection of 
the stabilized poles. The first two steps involve non-iterative procedures and result in solving 
linear algebraic systems of equations. Finally, in order to improve the estimation of the modal 
characteristics, especially for the challenging case of closely spaced and overlapping modes, a 
third step is introduced to solve a fully nonlinear optimization problem using available iterative 
gradient-based optimization algorithms. In this thesis, theoretical developments as well as 
software implementation issues are presented.

The methodologies and software developed are applied for the identification of the modal 
characteristics of a small laboratory structure for the case of artificial induced vibration 
measurements, as well as the identification of the modal characteristics of three bridges, the 
under construction R/C bridge of Egnatia Odos located at Metsovo (Greece), and two other 
representative R/C bridges of Egnatia Odos located at Polymylos and Kavala (Greece) for the 
cases of ambient and earthquake induced vibration measurements. Results provide qualitative 
and quantitative information on the dynamic behaviour of the systems and their components 
under different types of excitations.

All modal identification methodologies presented in this work are implemented in user-friendly 
software, termed Modal Identification Tool (MITooL). The software which includes graphical user 
interface allows the full exploration and analysis of signals that are measured on a structure when 
it is excited by artificial, ambient or earthquake loads. A user manual is also presented which 
gives details for the operations and prospects of the MITooL software. Step-by-step examples of 
modal identification are presented to demonstrate the applicability of the software.

Vll
Institutional Repository - Library & Information Centre - University of Thessaly
23/05/2023 01:59:53 EEST - 3.236.241.27



Contents

Chapter 1: Introduction.......................................................................................1
1.1 Overview of Operational Modal Analysis methods................................................4

1.2 Overview of Modal Analysis methods based on earthquake induced
vibrations.....................................................................................................................5

1.3 Outline and organization of the thesis....................................................................6

Chapter 2: Linear system analysis in time and frequency domains..............8
2.1 Introduction................................................................................................................. 8

2.2 Formulation for classically damped models...........................................................9

2.3 State space formulation of non-classically damped models...............................10

2.3.1 The eigenvalue problem.......................................................................................10

2.3.2 Orthogonality conditions.......................................................................................11

2.4 Observation equations........................................................................................... 13

2.5 Modal model............................................................................................................. 13

2.5.1 State space equations..........................................................................................13

2.5.2 Observation equations..........................................................................................14

2.5.3 Summary of modal model equations....................................................................15

2.6 Special case: Classically damped model............................................................ 17

2.7 The Frequency Response Function based on the modal model.....................18

Chapter 3: Cross power spectral densities in modal space......................... 21
3.1 Introduction............................................................................................................... 21

3.2 Modal decomposition of cross power functions.................................................. 21

3.3 Estimation of auto and cross power spectral densities...................................... 22

3.3.1 The periodogram approach................................................................................. 22

3.3.2 The correlogram approach...................................................................................23

3.3.3 The ‘positive’ power spectra approach................................................................ 25

3.3.4 Choosing reference responses........................................................................... 26

Appendix 3.A: Modal decomposition of cross power functions................................... 27

Vlll
Institutional Repository - Library & Information Centre - University of Thessaly
23/05/2023 01:59:53 EEST - 3.236.241.27



Chapter 4: Least squares methodologies for modal identification.................34

4.1 Introduction............................................................................................................... 34

4.2 Experimental Modal Analysis................................................................................ 36

4.3 Operational Modal Analysis....................................................................................37

4.3.1 Identification based on the full spectra.................................................................37

4.3.2 Identification based on the half spectra................................................................39

4.4 Earthquake induced vibrations..............................................................................40

4.4.1 Identification in the time domain.......................................................................... 41

4.4.2 Identification in the frequency domain................................................................. 43

4.5 Identification of closely spaced modes using simulated
measurement data..................................................................................................45

Chapter 5: Applications on input-output and output-only modal
identification..................................................................................................48

5.1 Introduction............................................................................................................... 48

5.2 Application on a three-story laboratory structure................................................48

5.2.1 Description of the laboratory three-story structure and instrumentation............. 48

5.2.2 Modal identification results...................................................................................51

5.3 Application on a Metsovo bridge during construction using ambient
vibration measurements......................................................................................... 59

5.3.1 Description of Metsovo bridge and instrumentation............................................59

5.3.2 Modal identification of Metsovo bridge................................................................62

5.4 Application on Polymylos and Kavala bridges using ambient and
earthquake induced vibration measurements..................................................... 64

5.4.1 Description of bridge systems and instrumentation................................................. 64

5.4.2 Modal identification of Polymylos and Kavala bridges.........................................67

Chapter 6: Modal Identification Toolbox (MITooL).............................................. 72

6.1 Introduction............................................................................................................... 72

6.2 MITooL Software..................................................................................................... 73

6.2.1 Installation notes for MITooL software................................................................73

6.2.2 MITooL Graphical User Interface (GUI)..............................................................74

6.2.2.1 Input files for MITooL..................................................................................75

IX
Institutional Repository - Library & Information Centre - University of Thessaly
23/05/2023 01:59:53 EEST - 3.236.241.27



6.2.2.2 The File menu............................................................................................ 76

6.2.2.3 The Preferences dialog box........................................................................76

6.2.2.4 The View menu...........................................................................................79

6.2.2.5 The Options menu......................................................................................80

6.2.2.6 The Identification Options dialog box........................................................81

6.2.2.7 The ΜΙΜΟ Options dialog box...................................................................83

6.2.2.8 The Full Spectra Options and the Half Spectra Options dialog boxes......85

6.2.2.9 The Quasi-Newton Options dialog box...................................................... 87

6.2.2 10 The Tools menu......................................................................................... 88

6.2.2.11 The Post Processing menu........................................................................ 89

6.2.3 The Stabilization Diagrams.................................................................................. 92

6.3 Step-by-step user guide to modal identification with MITooL software.........93

6.3.1 Modal identification application on G9 bridge at Polymylos using ambient
vibration measurements...................................................................................... 93

6.3.2 Modal identification application on G2 bridge at Kavala using simulated
earthquake induced vibration measurements....................................................106

Chapter 7: Conclusions................................................................................. 120

References ............................................................................................................................124

x
Institutional Repository - Library & Information Centre - University of Thessaly
23/05/2023 01:59:53 EEST - 3.236.241.27



Chapter 1

Introduction

During the last decade modal analysis has become a key technology in structural dynamics 
analysis. Starting from simple techniques for trouble shooting, it has evolved to an established 
technique to analyze the dynamical behaviour of complex mechanical structures. Beginning from 
the modal model, design improvements can be predicted and the structure can be optimized. 
Based on the academic principles of system identification, experimental modal analysis helps the 
engineers to get more physical insight from the identified models. Continuously expanding its 
application base, modal analysis is today successfully applied in civil engineering (buildings, 
bridges, off-shore platforms, dams), automotive engineering (engine, suspension, fully trimmed 
cars), aircraft engineering (in-flight tests, ground vibration tests, landing gear, control surfaces), 
spacecraft engineering (launchers, antennas, solid panels, satellites) and industrial machinery 
(pumps, compressors, turbines).

A great number of structures require certain specifications for safe and precise operation 
conditions, which usually form the most significant design parameters. In order to ensure a 
constantly accepted and reliable performance of a system, the knowledge of its dynamic behavior 
becomes essential in either case of operational or unpredictable extreme loads. For newly build 
structures, as well as for the ones that are already in operation for some time, the measurement 
of their dynamic properties, such as natural frequencies, damping factors and modeshapes is well 
desired, so as for the prediction of their behavior using a reliable model to be feasible.

The vibration of a structure originates from its resonance modes that are inherent properties of 
the structure. Small forces exciting the structure at one or more of these resonance frequencies 
can cause large vibration responses resulting in possible damage, discomfort and malfunctioning 
in the structure. These modes are determined by the geometry, the material properties (mass, 
damping and stiffness) and the boundary conditions of the structure. If the geometry, material 
properties or boundary conditions change, the structural modes change.

The modal model expresses the behaviour of a linear time-invariant mechanical system as a 
linear combination of these different resonance modes. Each mode is defined by a damped 
resonance frequency, modal damping and mode shape, i.e. the so-called modal parameters. 
Given the physical interpretation of the modes, engineers often prefer this mathematical model 
because it provides the best physical understanding for the system.

Experimental modal analysis (EMA) identifies a modal model from the measured forces applied to 
the test structure and the measured vibration responses. Classically, one applies an artificial, 
measurable input to the system and one measures the output. From these measurements, the 
experimental model can be obtained by a variety of parameter estimation methods. During an 
EMA, the structure is often removed from its operating environment and tested in laboratory 
conditions.

The latter experimental situation can differ significantly from the real-life operating conditions. 
Cases exist where it is rather difficult to apply an artificial force on a structure and one has to rely
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on available ambient excitation sources. For these cases, system identification techniques were 
developed to identify the modal model from the structure under its operational conditions from 
vibration responses only. These techniques, referred as operational modal analysis (OMA) or 
output-only modal analysis, take advantage of the ambient excitation as e g. wind, traffic and 
turbulence. OMA proved very useful in civil engineering, where it is very difficult and expensive to 
excite constructions such as bridges and buildings with a hammer or shaker and to obtain 
artificially induced vibration levels that exceed the natural vibrations due to traffic or wind. Also in 
mechanical engineering, OMA is successfully applied to obtain data-based dynamic models of, 
for instance, a vehicle during road testing or an aircraft during flight tests. Also, an important 
advantage of OMA is that the structure can remain in its normal operating condition. This allows 
the identification of more realistic modal models for in-operation structures.

For the cases of civil engineering structures, the response of the structure induced by an 
earthquake event can offer an opportunity to study quantitatively and qualitatively their dynamic 
behaviour within the resulting vibration levels. For the case of earthquake-induced vibrations, the 
modal characteristics are estimated from the measured portion of the excitation occurred to the 
structure and the measured vibration responses. These measurements are usually the 
acceleration of the structure obtained by accelerometers optimal placed on the structure 
(Papadimitriou et al. 2000; Papadimitriou 2005; Ntotsios et al. 2006). It has been observed from 
response measurements of large structures to potentially damaging excitations that the dynamic 
properties of many structures are markedly different during response to strong ground motion 
than in small amplitude ambient and forced vibration tests. Hence, it is of considerable interest 
and importance to extract information about structural behavior from strong motion data.

The identified modal model of a structure can be used for the following applications:

• Response prediction: The modal models are often used for the purpose of predicting the 
response of the structure to given dynamic loadings representing the real-life operating 
conditions. This allows designers to check the performance of a developed product under a 
variety of working conditions (Papadimitriou et al. 2001).

• Load identification: The modal model can be used to identify the unknown forces (full time 
history or other characteristics such as power spectra) using measured response time histories. 
This is also an inverse problem that has high practical value (Parloo et al. 2003).

• Model validation and updating: The modal properties, mainly identified modal frequencies and 
modeshapes, can be used to validate a finite element model (FEM) as well as update the values 
of various properties of the FEM, such as material properties, geometrical properties and 
boundary conditions, in order to obtain a reliable FEM model of the structure consistent with the 
measured data (Motterhead and Friswell 1993; Bohle and Fritzen 2003; Taughels et al. 2003; 
Lam et al. 2004; Christodoulou and Papadimitriou 2007; Christodoulou et al.2008). This updated 
finite element model can be used to carry out updated response predictions consistent with the 
test data.

• Structural health monitoring and damage detection: The modal properties of a modal model 
can be used for detecting damage in a structure by continuously monitoring the structure and 
exploiting the vibration measurements from the healthy and damage state of the structure (Farrar 
et al. 1994; Doebling et al. 1996; Fritzen et al. 1998; Vanik et al. 2000; Taughels and De Roeck 
2005; Ntotsios et al. 2008). The idea is that damage may be cause stiffness reduction at some
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locations of the structure. These stiffness reductions, which results from the onset of cracks or 
loosening of a connection, will cause changes in the modal properties of the structure. By 
monitoring these changes in the modal properties and coupling these changes with the finite 
element model, one should be able to detect the onset of damage in the structure as well as 
identify the location and the size of damage.

• Sub-structuring: The identified modal model can also be used to represent one or more 
substructures of a complex structure and then construct hybrid models of the full structure 
(Giagopulos and Natsiavas 2007) using sub-structuring techniques (Maia and Silva 1997). Given 
the modal model of different components of a complex structure, the dynamical behavior of the 
complete structure can be computed.

There are certain limitations in the effectiveness and reliability of the modal model identification 
techniques. These limitations are summarized as follows.

• Insufficient measurement data: This is due to the limited number of sensors placed in the 
structure. As a result only estimates of the partial modeshape of the structure are available at the 
measured degrees of freedom (DOF). Also, this is due to the usually limited range of the 
frequency band contained in the excitations forces that, as a result do not excite all modes of the 
structure and therefore some of the system’s dynamic properties cannot be identified. The 
problem is more pronounced with the higher frequency modes since, from a testing point of view, 
it is more difficult to excite the higher frequency response of a structure since more energy is 
required to produce measurable response at these higher frequencies than at the lower 
frequencies. It should be noted that optimal sensor location strategies could be used to give the 
best possible information about the modes of the excited system.

• Measurement error: These are errors associated with the dynamic data measurements. It 
consists of bias errors caused by faulty instruments or noise caused by changes in the 
environmental conditions during testing or poor preprocessing of the initial data (for example, bias 
from windowing of the data). The effect of noise on the modal identification results is that it limits 
the number of modes that can be estimated reliably. This is more pronounced for higher modes 
where there exists the signal-to-noise ratio is relatively small. Thus, often the modal parameters 
can be identified only for the dominant modes in the measurement records.

• Modal coupling: It is often difficult to identify the closely spaced modes which are contributing 
to the measured response within the measured frequency range of interest. This difficulty is 
observed more commonly at the higher frequency portions of the spectrum where the modal 
density is typically greater.

• Non-uniqueness: This is due to the fact that the number of parameters is larger than needed or 
the available measurements are relatively limited. In such case, the optimal solution to the 
identification problem appears not to be unique.

• Ill-Conditioning: This is due to the lack of sensitivity of the measurement quantities to small 
changes in the modal parameters to be identified.

• Model Error: This is due to the fact that the chosen class of linear modal models chosen for 
identification is unable to exactly model the actual behavior of the structure (for example, due to 
nonlinear behavior of the structure at a portion of the frequency range).

3
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1.1 Overview of Operational Modal Analysis methods
The peak-picking method (Felber 1993) is the simplest method to estimate the modal parameters 
of a structure subjected to ambient loading. It is based on the power spectra that are obtained 
from the measured time histories using discrete Fourier transform. The locations of the peaks of 
the power spectra give an estimate of the modal frequencies. The mode shapes are determined 
by computing the cross power spectral density functions between all outputs and a reference 
sensor. The method requires that the damping is low and the modes are well-separated. Violation 
of these two assumptions may lead to erroneous results. A disadvantage of the method is the 
subjective selection of modal frequencies and the lack of accurate damping estimates. However, 
the major advantage of the method is its speed. In general, the method identifies the operational 
deflection shapes instead of mode shapes, since there is no modal model that is fitted to the 
measured data. In particular, for the case of closely spaced modes such operational deflection 
shapes will be the superposition of the modeshapes of the multiple closely-spaced modes.

Nowadays, the stochastic subspace identification (Van Overschee and De Moor 1996, Hermans 
and Van der Auweraer 1999, Peeters and De Roeck 1999, Basseville at al. 2001) has been well 
developed and widely used for identifying the modal properties from ambient vibration 
measurements. In this method, a stochastic state space model is identified directly from 
measured output data or output correlations. It can be shown that this stochastic state space 
model is a good representation of a vibrating structure, provided that the unknown excitation 
forces can be modeled by white noise processes. Successful real-life modal analysis applications 
of stochastic subspace identification can be found in the literature (e.g. Hermans and Van der 
Auweraer 1999; Peeters 2000; Basseville at al. 2001).

Statistical methods for the estimation of the modal parameters based on output-only 
measurements have also been proposed. Frequency-domain maximum likelihood approaches for 
the estimation of modal parameters from output-only data were proposed by Hermans et al. 
(1998), Guillaume et al. (1999), Verboten (2002), Parloo (2003) and Cauberghe (2004). A 
Bayesian statistical approach for modal identification has also been proposed by Katafygiotis and 
Yuen (2001) using ambient data. The method is based on the statistics of an estimator of the 
spectral density. This approach allows for the direct calculation of the probability density functions 
(PDF) of the modal parameters which can then be approximated by an appropriately selected 
multi-variant Gaussian distribution.

Besides the aforementioned modal identification approaches, several methods proposed are 
based on fitting directly the measured data with modal model predicted data using least-squares 
type of approaches. In Beck et al. (1994) a methodology for modal identification is proposed 
using time-domain least-squares methods based on correlation functions of the output time 
histories. In Brinker et al. (2001), Verboten (2002) and Cauberghe (2004) frequency-domain 
least-squares methods based on full cross-power spectral densities (CPSD) are proposed. 
Finally, Peeters and Van der Auweraer (2005) have proposed a frequency-domain least-squares 
modal identification methods based on half spectra.

There are certain advantages for using output only measurements for identifying the structural 
modes. In operational modal analysis there is no need to use artificial devises for exciting the 
structure (Farrar et al. 1994). Instead, the modes are identified from the vibrations obtained 
during the operation of the structure. This has certain advantages for massive civil structures for 
which large exciters have to be used to excite the structure. The use of exciters is not only very
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costly but it is also time-consuming and impractical (Peeters and De Roeck, 1999) for structural 
health monitoring applications. Ambient vibration measurement can directly be used for 
continuously monitoring the civil engineering structures (Peeters, 2000; Peeters and De Roeck, 
2001). Such ambient vibration measurements have also been recently used in identifying the 
modal characteristics of ground and air vehicles (Peeters et al., 2004; Souty 2008; Boswald and 
Govers 2008, Klepka and Tadeusz 2008, Peeters et al. 2009). Finally, it is worth noting that the 
OMA methods provide the modal properties that correspond to the real operation conditions of 
the structure. These conditions may differ significantly from the ones obtained during laboratory 
forced excitation tests. Examples of this situation include the modal properties obtained for 
bridges using large exciters. Such modal analyses are usually performed under closed traffic 
conditions. For bridges that are open in traffic, one should expect changes in mass loading due to 
the vehicles passing through the bridge (Kim et al., 2001; Roberts, 2001). These changes alter 
the modal properties of the structure.

The disadvantages of the operational modal analysis methods are the broadband assumptions on 
the unknown input and the low signal to noise ratios for the low level vibrations on which usually 
the measurements are made. In particular, all operational modal analysis methods are based on 
the fact that the unknown input forces can be adequately modeled by white noise processes. This 
condition is often violated since excitation forces may contain harmonic components which will 
appear as peaks in the spectra and may be erroneously identified by the methods as structural 
modes.

1.2 Overview of Modal Analysis methods based on earthquake induced 
vibrations

For the case of earthquake-induced vibrations, modal identification algorithms provide estimates 
of the modal frequencies, modal damping ratios, modeshapes at the measured DOFs and modal 
participation factors using classically-damped or non-classically damped modal models. Modal 
identification methods have been developed in time domain (Beck 1978; Beck and Jennings 
1980) and in frequency domain (McVerry 1980), based on a minimization of the measure of fit 
between the time history or its Fourier transform of the acceleration responses estimated from the 
measurements and the corresponding ones predicted from a classically-damped modal model of 
the structure. These methodologies have also been extended to treat non-classically damped 
modal models, since damping may not be proportionally distributed in various structural 
components.

Specifically, Beck (1978) and Beck and Jennings (1980) had presented an output-error approach 
for the identification of linear, time-invariant models from strong motion records. McVerry (1980) 
has applied an output-error approach in the frequency domain, using the Fast Fourier Transform 
(FFT) of the acceleration response time histories to estimate the modal properties through least- 
squares matching. Werner et al. (1987) formulated a methodology in the time domain for the case 
of measured input excitation, such as earthquake excitation, for an elastic system with classical 
normal modes and with motion measurements from any number of input and system response 
DOFs. Their procedure was an extension of the least-squares-output-error method which was 
used by Beck (1978). Extensions for identifying non classically-damped modal models in the 
frequency domain have been developed by Chaudhary et al. (2002). Tan and Cheng (1993) 
proposed an iterative identification algorithm, which was based on the modal sweep concept and
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the band-pass filtering process, to identify the modal parameters of a non-classically damped 
linear structure from its recorded earthquake response. Mahmoudabadi et al. (2007) developed a 
method for parametric system identification in frequency domain for classically and non- 
classically damped linear systems subjected up to six components of earthquake ground motions, 
which is able to work in multi-input/multi-output (ΜΙΜΟ) case. Nikolaou (2008) has recently 
extended the work by Beck (1978) and McVerry (1980) to the use of non-classically damped 
models. A novel aspect of Nikolaou (2008) method is to use a three step approach to distinguish 
the physical from the mathematical poles using stabilization diagrams and reduce the 
computational time for estimating the modal parameters of the physical modes by re-formulating 
the optimization problems in terms of quadratic objective functions.

1.3 Outline and organization of the thesis
In this thesis modal identification methodologies for estimating the dynamic modal characteristics 
of structures have been developed. A generalized non-classically damped modal model of the 
structure is considered and the identification is based of vibration measurements induced by 
artificial-, ambient- and earthquake-induced excitations. An output error formulation is used in 
which the modal parameters are identified through least-squares matching between the output 
measured response of the structure and the predicted by a modal model of the structure 
subjected to the different excitation types. A three step approach is proposed to solve the output 
error optimization problem. The first step provides estimates of the modal frequencies and modal 
damping ratios by solving a system of linear algebraic equations. Stabilization diagrams are used 
to distinguish between physical and mathematical modes. The second step provides estimates of 
the modeshapes and the modal participation factors by solving a system of linear algebraic 
equations. The first two steps usually give accurate estimates of the modal characteristics. A third 
step is added to improve these estimates, if needed, by efficiently solving the full nonlinear 
optimization problem with initial estimates of the modal parameters those obtained from the first 
and second steps.

The identification algorithms have been implemented in the software Modal Identification Tool 
(MITooL) with Graphical User Interface (GUI) environment. The MITool has been developed in 
the System Dynamics Laboratory of the Department of Mechanical Engineering of the University 
of Thessaly. The GUI is fully adaptable to satisfy the user’ s requirements by allowing the 
resetting of most of its operational parameters. The effectiveness and applicability of all 
identification algorithms and software are using simulated measurements, as well as real 
measurement from laboratory model structures and fully operational bridges.

The thesis is divided into seven chapters.

Chapter 2 presents the linear system theory that is used to describe the characteristics of the 
response of linear structures in the time and frequency domains in terms of the modal 
coordinates. Several mathematical models are discussed that can be used to describe the 
dynamical behavior of a structure with a limited number of modal parameters. The formulation is 
presented for the general case of non-classically damped modes. The classically damped case is 
then formulated as a special case. Both continuous and discrete time formulations are presented. 
The Frequency Response Functions (FRF) are formulated using different mathematical models 
like state space models and matrix fraction polynomial models.
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Chapter 3 deals with the modal decomposition of output-only data in the frequency domain. It is 
shown that, analogous to FRF data, modal parameters can be identified from cross power 
spectra of output-only data. For this, available methods are used for the estimation of auto and 
cross power spectra from measured response data sets.

In Chapter 4 several modal identification methodologies are proposed to solve the modal 
identification problem for the cases of artificial, ambient and earthquake induced vibrations. 
These modal identification methodologies provide estimates of the modal properties (e.g. modal 
frequencies, modal damping ratios, modeshapes and modal participation factors) of a structure. 
All these methodologies introduced are based on the minimization of an error function using a 
least squares minimization approach. The formulation is presented for the general case of non- 
classically damped modal model. The proposed modal identification methodologies use a three 
step approach to solve the output error minimization problem. The first step provides estimates of 
the modal frequencies and modal damping ratios. In addition, using stabilization diagrams, the 
physical poles are distinguished from the mathematical poles. The second step provides 
estimates of the modeshapes and the modal participation factors and the third step improves 
these estimates by solving a nonlinear optimization problem. A modal identification example 
using simulated measurements is presented for the case of a structure with closely and 
overlapping modes showing the efficiency of the proposed three step identification approach and 
the need to use the third step for the case of closely spaced and overlapping modes.

In Chapter 5 the proposed identification methodologies are applied to real structures. The 
purpose of this chapter is to demonstrate and compare the applicability and effectiveness of the 
modal identification methodologies. The dynamic modal characteristics are estimated for a small 
scale laboratory structure using artificially (impulse hammer) excited vibration measurements and 
for three bridges on the Egnatia Odos motorway (G9 Polymylos, G2 Kabala and Metsovo 
bridges) using both ambient and earthquake induced vibration measurements.

Finally, Chapter 6 presents the MITooL software that has been developed to implement all the 
identification algorithms discussed in the present thesis. All the operations and prospects of the 
MITooL software are presented in details. A step-by-step user guide is also presented for 
identifying the modal characteristics of two bridges using real ambient vibration response 
measurements and earthquake induced vibration response measurements.

Conclusions of this work are summarised in Chapter 7.
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Chapter 2

Linear system analysis in time and frequency domains

2.1 Introduction
This section uses linear system theory to solve the equations of motion that govern the response 
(displacement, velocity and acceleration) of structures. Modal analysis is used to describe the 
response at the measured (observable) degrees of freedom of the structure in terms of the 
eigenproperties (eigenvalues and eigenvectors) and the excitation. The analysis is used in 
subsequent Chapters for solving the inverse problem of identifying the eigenproperties given 
input-output and output-only measurements.

Using a spatial discretization method, such as finite element analysis, the equations of motion for 
a linear structure are given by the following set of n second order differential equations

M q(t) + C0q(t) + Kg(t) = Lf(t) (2.1)

where q(t) 6 R"xl is the displacement vector, M , C0 and K e R',x" are respectively the mass, 

damping and stiffness matrices, f(t) e RAi,"xl is the applied force vector at the Nm DOFs, and 

L e RnxN"‘ is a matrix comprised of zeros and ones that maps the Nm excited DOFs to the n 

output DOFs. Throughout the analysis, it is assumed that the system matrices M , C0 and K 

are symmetric.

Linear system theory is used with the objective to describe the solution of the system in the time 
domain in terms of the modal coordinates. The formulation is presented for the general case of 
non-classically damped modes. The classically damped case is then formulated as a special 
case. Both continuous and discrete time formulations are presented. All results given in this 
Chapter are well known. Their presentation is given herein in order to make this Thesis self- 
contained.

The presentation is divided into the following sections. Section 2.2 gives known modal analysis 
results for formulating the response of the structure in terms of real modal coordinates for a 
classically-damped model (2.1). Sections 2.3 to 2.5 extend the formulation to the general case of 
a non-classically damped model (2.1). For this, the state space form of system (2.1) is used and 
the corresponding complex-valued modal analysis results are presented. Section 2.5.3 gives a 
summary of the formulas that describe the response of the structure at the measured locations in 
terms of the complex eigenproperties (eigenvalues and eigenvectors). Section 2.6 presents the 
modal analysis formulation for the classically damped modal models as a special case of the non- 
classically damped modal models. Finally, Section 2.7 presents the formulation for the transfer 
function between the output and the input DOFs using the non-classically damped modal model.
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2.2 Formulation for classically damped models

Assuming that the structure is classically damped and that the system matrices M, C0 and 

K e R"x" are symmetric, the solution for the displacement response q(t) e R"xl in the modal 

space can be written in the form:

£(0 = Σ££(') = φί(') (2-2)
r=\

The modal coordinates ξΓ (f) are given by the modal equations

l(t) + 2 ζ,ω,ξ, (t) + ω]ξ, (/) = £lf(t) (2.3)

where cor is the modal frequency, ζΓ is the modal damping ratio and φr is the modeshape 

vector for the r mode. The modeshapes φ ,r = , are real and satisfy the orthogonality

conditions

where

-r —s

= «η r = l,...,#i, s = l,...,n (2.4)

= ω)δη r = \,...,n, s = \,...,n (2.5)

\\, r = s 

[0, r^s
(2.6)

is the Kronecker delta. Equivalently, in matrix form the orthogonality condition (2.4) and (2.5) are 
written as

Φ1 ΜΦ = 1 

ΦίΚΦ = Ω2

(2.7)

(2.8)

φ^ ··· φηJ is the matrix of modeshapes and Ω2 is a diagonal matrix of thewhere Φ = 

squares of the modal frequencies given by

Ω2 =
OX

co„

(2.9)

Note that all variables involved in the classically damped analysis presented in this section are 
real and the modal equation are second order differential equations. In contrast, the variables in 
the non-classically damped modal analysis presented in Section 2.3 are in general complex, 
while the modal equations are first order differential equations. It can be shown that the two
formulations for describing the response in the modal space are equivalent.
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2.3 State space formulation of non-classically damped models
In the general case where the system is non-classically damped the set of equations (2.1) must 
be converted to a set of first order state space formulation. This is accomplished by introducing 
the complementary equation

Mq(t) = Mq(t) (2.10)

and the state vector

(2.11)

Equations (2.1) and (2.10) can be written in the state space form

Px + Qx

where the matrices P and Q are given by

[Co M ~K 0 '
, Q =

M 0 _ 0 -M

(2.12)

(2.13)

2.3.1 The eigenvalue problem

The eigenvectors ψ and the corresponding eigenvalues λΓ satisfy the eigenproblem

(Ρλ + ζ))ψ = 0 (2.14)

The eigenvalues λΓ and the eigenvectors ψ are complex and it can be shown that if λΓ and
* *

ψ are the eigenvalues and eigenvectors of the eigenproblem then Ar and ψ r are also 

eigenvalues and eigenvectors of the same eigenproblem.

Introducing the eigenmatrix ψ = [V, ··· ψ„ψ\ ··· (//,*JeC2”*2'1 it can easily be shown

that the eigenmatrix of the eigenproblem (2.14) is given by

Φ Φ*
ΦΛ Φ*Λ

eC2nx2n (2.15)

where Φ, λ satisfy the second order eigenproblem

ΜΦλ2 +C^X + K<& = 0 (2.16)

The eigenvalues λΓ are given by

λΓ=-ζΓωΓ±]ωΓ^ζϊ (2.17)

where
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ωΓ =\λ\ and (2.18)C="
Re{A,.}

C0„

The eigenvalue matrix for the first order linear system (2.12) is given by

'A 0
Ae =

where Λ is the diagonal matrix

0 Λ
= diagonal e C2nx2n

A =
4

0

0

λ

(2.19)

(2.20)

2.3.2 Orthogonality conditions

The complex eigenvectors satisfy the orthogonality condition

Ψ7 ΡΨ = diag[ar]

that can by written as

P = ^T diag[ar\¥~x

The eigenvectors also satisfy the orthogonality condition

= diag[Pr]

that respectively can by written as

Q = ^-Tdiag[Pr\V~x

Pre-multiplying (2.14) by ψ1 yields

ψτ Ρψλ + ψΊ ζ)ψ = 0

and solving for λ gives

, ψΩψ

ψ Ρψ

For the r-th eigenvalue and eigenvector, the last expression gives

ψΤζ)ψ^   ——r L—r

r ~ ψτΡψ
L—r 1—r

The r-th eigenvalue is finally given by

(2.21)

(2.22)

(2.23)

(2.24)

(2.25)

(2.26)

(2.27)
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(2.28)λ.. ==-Pr/
a..

where

βΓ=Ψ,ΩψΓ

ar =ψ[Ρψ

and the eigenvalue matrix is given by

Ac = diag

(2.29)

1/
a. diag[pr] (2.30)

The normalized state space formulation is obtained by pre-multiplying equation (2.12) by Pi-l

p-] = 0 M~

Μ -M CnM~

The normalized state space equations take the form

x = Acx + Bcf(t)

where

Ac -~P~'Q =

is the state space matrix and

0 M~' ~K 0 ' 0 I

0 -M

----
1

u°
T

1

7

1

___
1

(2.31)

(2.32)

(2.33)

~L 0 ΛΤ1 ~L 0
p-' — —

0 0

1

1

1

Based on the eigenproblem (2.14) and pre-multiplying (2.14) by P 1 yields

{-ρ-'ζ)-λΙ)ψ_ = 0 => (Ac - λΙ)ψ_ = 0

For the r-th eigenvalue and eigenvecor, the last expression can be written in the form

ΑΨ_γ=ΚΨ_,< r = \,...,2n

In matrix form, the set of 2n equations (2.36) can by written in the form

4.Ψ = ΨΛ

that gives
ΨΛ ψ-ι

(2.34)

(2.35)

(2.36)

(2.37)

(2.38)

Formulation (2.37) shows that the matrices At. and Ψ contain the eigenvalues and eigenvectors 

of the state space matrix Ac.
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2.4 Observation equations

Let y(t) e R^0 be the response vector of interest. These responses, in general case, are a linear

combination of the accelerations, velocities and displacements of the system. The generalized 
observation equation is given in the form

y^ = Cj{t) + Cvq{t) + Cdq(t) (2.39)

By writing q{t) as a function of q(t) and q(t) using (2.1) and substituting in (2.39) yields

y(t) = cex+Def(t) (2.40)

where

C,=\Ci-CaM"'K I C,-C„M_IC0] (241)

and

Dc = CaM~lL (2.42)

2.5 Modal model
2.5.1 State space equations
For the realization of modal analysis method the following transformation is introduced

ί(0=ψί(0 <2·43)
where ξ is the vector of the main modal coordinates. Substituting eq. (2.43) in (2.32) and pre

multiplying by Ψ-1 the following expressions are obtained

Ψ# = 4Ψ| + 5,/(0 (2.44)

or equivalently

ΐ = Ψ"'4Ψ£ + ψ·|£<:/(/) (2.45)

Using the eigenvalue problem (2.37), one finally obtains the equations

l = AJ+LJ(t) (2.46)

where

L = ψ_15 (2.47)

The last equation (2.46) is the state space equations for the modal coordinates <%(t) The Lc 

term can be simplified using equation (2.22) which is solved with respect to Ψ"1 to yield

ΨΡ (2.48)

By substituting the last expression in (2.47) and using (2.15) and (2.13) results in
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(2.49)

Lc = Ψ lBc = diag

= diag

ΨΤΡ
0

M~XL

ar

1*Θe1___

T

'Co M~ 0

ΦΛ j Φ Λ* M 0_

“ 
1 

7

Carrying out the matrix multiplications, the above equation finally simplifies to

Lc = diag 1/ ’φΓ~

Φ’Γ
(2.50)

The Lc matrix is the participation factor matrix. Using modal coordinates equations (2.50) result 

in

1 jT
ξΓ (0 = KZr (0 +—r = \,...,n

ar ~

Lr (0 = 4-V„+r (0 + £lrLf (0 - r = \,...,n

(2.51)

(2.52)

with

&+r = £ and αΛ+,=«* (2-53)

Note that the complex equation (2.52) is the complex conjugate of the complex model equation 
(2.51).

2.5.2 Observation equations

The response y{t) defined in (2.40) can be expressed using modal coordinates by substituting 

the transformation (2.43) in (2.40) to yield

y(t) = QVl(t)+Dr/(t) (2.54)

or equivalently

y(')=Ki(i)+Dcf(t) (2.55)

where *II (2.56)

The matrix Vc e CA,°x2" is called the modal response observation matrix and can be simplified
using equations (2.41) and (2.15) into the form

V -

i-----
*ΘΘ1

(2.57)Vc - ΦΛ ' Φ Λ*

Let us now consider the following three special cases:
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The response _y(0 consists of the displacements only, that is Cu = Cv = 0 and Cd * 0. The Vc 

matrix takes the final form

K = [cj ! o]
φ j φ* 

φλ [φ'λ7
= ^[φ|φ·] (2.58)

The response y(t) consists of the velocities only, that is Ca—Cd= 0 and Cv Φ 0. The Vc 

matrix takes the final form

Ve=Cv[OA | Φ*Λ*] (2.59)

The response y(t) consists of the accelerations only, that is Cv = Cd = 0 and Ca Φ 0. The Vc 

matrix takes the final form

φ ! φ

ΦΛ \ Φ*Α' (2.60)

= -Ca[M-'K<& + M-lC0(&A \ Μ~'ΚΦ' +M-'C0<&'Λ*]

that can be simplified further using the eigenproblem (2.16). Specifically, from (2.16) one has

Μ~ιΚΦ + Μ~'(Γ0ΦΛ = -ΦΛ2 (2.61)

or equivalently by taking complex conjugates

Af-'ΚΦ' + M~'C0 Φ*Λ* = -ΦΛ*2 (2.62)

Substituting the last two expressions into (2.60), V. is given by

Vc =Γα,[φΛ2 j Φ*Λ*2] (2.63)

2.5.3 Summary of modal model equations

Summarizing, for the case of general non classically damped systems, the modal model consists 
of the modal state space equations (2.46) and the modal observation equations (2.55), that is,

i=\l + LJ(t) (2.64)

y(t) = V'i(t)+DJ(l) (2.65)

where
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is the modal coordinates vector

m=- 4(0

4(0
• e C2"*1

A„
Λ 0 

0 Λ*

(2.66)

(2.67)

is the matrix that consists of the complex eigenvalues Xr of the system,

L = Ψ~ιΒί = diag 

is the participation factor matrix,

1/ φ7

.A. o*r
LeC2nxNm

fit) e

is the independent vector of excitations,

Dc = CaM~lL e Ra>a;"

(2.68)

(2.69)

(2.70)

is a matrix that is zero if no accelerations are contained in the response vector y(t), and

Vc e CN°*2" is a matrix given by

II [φ φ'] for displacements (2.71)

wII ΦΛ Φ’Λ’] for velocities (2.72)

u
3

II [ΦΛ2 Φ*Λ*2] for accelerations (2.73)

Consider next the case for which Cd , Cv and Ca in (2.39) are observation matrices that assign

a correspondence between the model degrees of freedom and the observation (measured) 
degrees of freedom. In this case note that:

U = CJ& = [ui ··· w,,] (2.74)

is the eigenvector matrix at the desirable (measured) degrees of freedom that are included in the 
response vector jy(/) for the displacements. Similarly, taking into account that Λ is diagonal

yields

CV0A = [4«, - Xnu\ (2.75)
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is the eigenvector matrix at the desirable degrees of freedom that are included in the response 
vector y(t) for the velocities. Similarly, taking into account that A2 is a diagonal matrix,

C„0A2=[^ - 4k] (2-76)

is the eigenvector matrix at the desirable degrees of freedom that are included in the response 
vector y(t) for the accelerations.

Based on the above formulations the response y{t) e at the Nn degrees of freedom of the 

linear model is given by

y{t)=[u u*]£(t)+Dcm (2.77)

where

u = [ux,....un\&CN°*n (2.78)

is the eigenvector matrix at the desirable degrees of freedom. Consequently, the system 
response for either displacements or velocities or accelerations is fully defined when the elements 
of the matrices Ac, Lc, U and Dc are known.

From the previous analysis, it is evident that the response y(t) of the linear structure at selected 

degrees of freedom can be completely defined by knowing the parameters set Θ that includes all 
entries involved in the matrices Λc,£c, Vc and Dc.

2.6 Special case: Classically damped model
The aforementioned equations for the general case of non-classically damped system are 
simplified in this paragraph for the case of classically damped systems and assuming that the 
structure matrices M, Cn and K e R"x” are symmetric. From the analysis of classically 
damned structures with symmetric matrices, it is known that the resoonse is aiven bv

q = φβ* (2.79)

where φ e K" is a real modeshape vector. In this case the matrix of modeshapes Φ e R''x", 

defined in (2.15). is also a real matrix

Consequently, substituting in (2.15) the complex modeshape matrix, Ψ is given by

* Φ Φ 
ψ = *

ΦΛ ΦΛ

Substitutina the above eauation into the orthoaonalitv condition (2 21) yields

(2.80)

Λα^[αΓ] = ΨτΡΨ -
diag

0

0

-diag 2cor^yr
(2.81)
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and substituting (2.81) in (2.68) yields

4=-7

diag

0 -diag 2.^

-φΓ"

e (2.82)

Using (2.51) and (2.52), the modal coordinates ξΓ (?) and ξ\ (?) are written in the form

l (0 = Ktr +----------- XT==<t>TLi\t) (2.83)
2ωΓ^\-ζ] ~r ~

g(t) = KK +-------- l-j—4>TLm (2.84)
-2ω,φ-C2 "

The system of equation (2.83) and (2.84) can thus be written in the complex form (2.64) where 
Lc is an purely imaginary matrix given by (2.82). Using (2.55) to (2.57) and (2.80), the response

vector y(t) is given by the observation equation

y(t) = Vcl(t) + DJ(t) (2.85)

where

V. = C
Φ Φ 

ΦΛ ΦΛ*

C'=[Cd-C,M-'K |C,-C„M-'C0] 

D^C'M-'L

(2.86)

(2.87)

(2.88)

2.7 The Frequency Response Function based on the modal model
For the system that has resulted following the aforementioned analysis we will use Fourier 
transform that results in the frequency domain equivalent, and at the same time transforms the 
differential equations into algebraic. Generally, a function g{t) can be analyzed using Fourier
components

“\g(co)eJ,md(o

where g{o>) is the Fourier coefficient given by

g(jo))= J g(t)e~IC0ldt

(2.89)

(2.90)

Applying the Fourier transform to equation (2.1) in the frequency domain yields

qijco) = H (jm)Lf(jiy) (2.91)
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where

H{ja>) = [Μ{]ω)2 + C(jco) + κ}' (2.92)

The matrix H(jo>) is called transfer function matrix.

It has already been mentioned that from the set of differential equations in (2.1) has resulted into 
a set of algebraic equations in (2.91).

The modal equations (2.46) and (2.55) can be formulated in the frequency domain
Λ',

y(t) = Σ ter ξ, (0+μ* ξ\(0)+Σ ^Jk (0
r=1 k-\

(2.93)

where

i(0 = Vr(0 + i/(0 (2.94)

£(0=4£(0+£7(0 (2.95)

λΓ=-ζΓωΓ±]ω^\-ζ2 (2.96)

and the vector is the A: -th column of Z).

A=[rf, - J (2.97)

Using the Fourier transform, the relation between the response y(jco) and the excitation 

f( jco) in the frequency domain is given by

where

y(jco) = H (ja>)f {jco) + DJ(Je>)

Ηυω) = Σ
r=\

u.l.
- + -

* 7*7

ja-Xr jto-/lr

In matrix form equation (2.99) can be written as

H(j e>) = U [ja>I„ — A] ' LTC + U' [./«/„ - A* ]"' L'J

with

(2.98)

(2.99)

(2.100)

(2.101)
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is the Transfer Function matrix that is formulated with respect to eigenvectors ur, participation 

factors l_r and eigenvalues λΓ and define the Frequency Response Function (FRF) matrix 

between the n outputs and the Nm inputs.

It should be noted that the second term in the right-hand side of equation (2.98) is non-zero only if 
the response vector of interest y(jco) include terms for the system acceleration.
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Chapter 3

Cross power spectral densities in modal space

3.1 Introduction
The following chapter will deal with the modal decomposition of output-only data in the frequency 
domain. It will be shown that, analogous to FRF data, modal parameters can be identified from 
cross power spectra of output-only data. The estimation of the power spectra between the 
outputs and the reference outputs is discussed. The auto and cross power spectral density 
functions are the primary data for model parameter identification based on output-only (ambient) 
measurements. Basically, two classical approaches exist for the estimation of auto and cross 
power spectral density functions. The periodogram estimator operates directly on the spectra of 
different time blocks resulting from a division of the time sequences. The correlogram approach 
first estimates the correlation functions in the time-domain and next the power spectra are 
obtained by transferring the correlations to the frequency-domain. Finally, the estimation of the 
half (or positive) power spectra is also discussed.

3.2 Modal decomposition of cross power functions

Consider a n DOF representation of a linear mechanical system given in (2.1). Let fit) e Rw,n

denote the force input vector at continuous time t and x(/) e R" the output displacement vector. 
Let the (n x NJ Frequency Response Function (FRF) matrix between the outputs and inputs be 

given by equation (2.99)

Σ
,τ 

—r Lr

ίω-λΓ
+ -

* ,*τ ulr

ja>~K
(3.1)

where λΓ, ur and lr are respectively the pole, mode shape and modal participation factor of 

mode r , and Nm is the number of contributing modes modes with Nm < n.

It is known from literature (Ljung, 1999) that for stationary stochastic processes the cross power 
spectral density matrix Sxx(jG>) e CN""*N,m' of the response vector x(t) can be written as a

function of the transfer function H(jty) and the cross power spectral density matrix Sff{jco) of 

the (unknown) force vector /(t) as follows:

SJj-ω) = HUo>)Sff(ja>)H'T(ja>) (3.2)

Assuming that the forces acting on the structure are white noise sequences, then the cross 
power spectral density matrix of the forces is constant, independent of jco, given by

Sff(ja>) = S0 that is real.In this case equation (3.2) is written in the form
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(3.3)S^jw) = H(jco)S0Uc»)H'T(jco)

It is shown in the Appendix 3.A that by assuming white noise inputs and substituting (2.99) in 
(3.3) the matrix cross power spectral density matrix S^(jco) of the responses evaluated at 
frequency ω, can be modally decomposed as follows

•u»=Σ Hrg,
• *T T

Hr g, | 8rHr
- + -

8 u
•t

r=1 j® - Λ je»-Xr -ja>-lr -jo)-λ.
(3.4)

where ur is the complex modeshape of mode r of the linear system and gr is the operational

reference vector for mode r given by eq. (3.28) in Appendix 3.A. This reference vector is a 
complex function of the cross power spectrum matrix of the unknown random input forces and the 
modal parameters of the structure but its physical interpretation is less obvious than the modal 
participation factors. It should be noticed that the modal decomposition of the power densities of 
the outputs has a symmetry in the poles i.e. both the positive and negative poles are present in 
the model. This symmetry is referred to as a 4-quadrant symmetry. Given this similarity between 
the modal decomposition of the cross spectral densities of the outputs and the modal 
decomposition of the FRFs, the modal parameter estimation techniques developed for FRFs can 
be extended to handle the case where the cross power spectral density matrix is available from 
output-only data.

3.3 Estimation of auto and cross power spectral densities
In order to use equation (3.4) for the identification of modal parameters from output-only data, 
accurate estimates of the cross power spectral densities, between the responses, are to be 
obtained from finite sequences of measured time samples. Basically, two classical methods exist 
for the estimation of auto and cross power spectral density estimates (Marple 1987), the 
periodogram and the correlogram approach. The periodogram (Marple 1987) method operates 
directly on the data set to yield power spectrum estimates. The correlogram approach (Blackman 
and Tukey 1958) first makes an estimate of the correlation functions in the time-domain and then 
proceeds by Fourier transforming the correlation sequences into power spectral densities. For 
both approaches, the user is faced with a tradeoff to produce statistically reliable estimates of 
highest possible spectral resolution from finite sequences of measured time data. For 
completeness, these methods are briefly presented. Parts of the presentation that follows have 
been taken from the work of Parloo (2003) and Cauberghe (2004).

3.3.1 The periodogram approach

The periodogram method is a popular method for the estimation of auto and cross power spectral 
densities (Marple 1987). Let xn{m), m = 0,···,Μ-1, o = 1,···,Nout be an assembly of Noul

discrete time-domain output sequences. Let xreJ (m) be a sub-vector of x{m) containing the 

time sequences of Nref outputs which are serving as reference-responses for the measured data

set. The basic idea of the periodogram method is to divide the data sequence for each measured 
output of M samples into P non-overlapping segments of D samples each, so that DP < M.
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As an alternative to choosing no common samples between adjacent segments, a small overlap 
can be used (Welch, 1967). For each segment s , s = 0,···,Ρ-\, the discrete Fourier transform
of the signal x0(rri) for all considered responses o , o = l-,Nmil , weighted with a time window 
W of length D, can be computed as

A similar expression can be found for all reference responses i, / = 1, —, Nref , assembled in the 

sub-vectors xref (m)

An estimate of the entries of the (Nolil x Nr,) cross power spectral density matrix S( ja>) for 

each response reference-response combination, evaluated at discrete frequency ω, is given by

where Xs0(Jco) and Χ*’ηί (joj) are respectively the (Nollt x 1) and (Nref xl) vectors 

computed in (3.5) and (3.6).

The time window W (e.g., Hanning window) is used to reduce the negative effect of leakage. 
Choosing a higher amount of data samples D in each segment, at the expense of the number of 
averages P, will reduce the effect of leakage. Moreover, a higher spectral resolution will be 
obtained in the frequency-domain. However, the resulting decrease in the number of averages P 
leads to a higher stochastic uncertainty on the estimates. In practice, a trade-off will have to be 
made between these contradicting aspects.

Note that the basic idea behind allowing an overlap between the data segments consists in 
allowing a better contribution of all samples of the raw time history response data to the averaged 
estimate. If no overlap is considered, the contribution of samples near the edges of the segments 
will be suppressed by the presence of the Hanning window.

3.3.2 The correlogram approach

The periodogram approach can be used as an alternative to the periodogram method for the 
estimation of cross power spectra of the response signals. This method computes the unbiased 
discrete-time domain correlation estimate between the signal xjm), m = 1, of a

response o and the signal x-ef(tn) of a reference-response i. This correlation estimate is given

(3.5)

by
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1
for 0 < k < Μ -1

\l-k-1

Ro.Sk) = -rr-T Σ xo(m + k)x'el (m)M — k ,„=0

} A/—j/rj 1 (3.8)

M-|*| t.
£ (w +|*|)xn (m) for - (Μ -1) < k < 0

with k the correlation time. The biased correlation estimate uses 1 /M rather than 1 /(M—kY

The cross power spectral density function matrix estimates can then be obtained by Fourier 
transforming the correlation functions obtained from (3.8)

M
S„Ajv) = Tx £ W(k)RJk)e-^ (3.9)

k=-M

where R(k) is the (Nolll x Nre/) matrix that contains the correlation estimates calculated in (3.8) 

and W(k) is a (2M + 1) point time window.

The window reduces the effect of leakage due to the large side lobes of the implicit rectangular 
window and therefore the bias error in the cross power spectral density estimate. The use of an 
adequate window (e g., Hanning, Hamming, etc), symmetric around the origin, is advisable. For 
instance, applying a Hanning window to the correlation estimate will force the correlation to zero 
at the higher lags. Moreover, the application of such a window reduces the stochastic uncertainty 
on the cross power estimate due to the presence of a higher stochastic uncertainty near the 
higher lags of the correlation function estimate. However, when applying a time window, the poles 
(and especially the damping) of the underlining system will be affected. However, for an 
exponential window, the poles can be compensated exactly for the added damping. This is not 
the case for other windows such as Hanning or Hamming.

Hence, for the purpose of modal parameter estimation, the correlogram approach is best 
combined with the use of an exponential window. Given the form of the correlation function 
estimates, a double sided exponential time data window centered around 0 ,

Win=e~p^Ts with -M<m<+M (3.10)

with β a decay factor, can be used. The poles λβ extracted from the estimates can be

compensated (corrected) for the artificial damping added by the window by using the value of the 
β factor as follows

λβΓ=λβ'+β (3.11)

Although an averaging procedure is usually not strictly required, the possibility exists to use an 
averaging similar to the periodogram approach. If the time history response sequences consist of 
M samples, every response sequence can be divided into P non-overlapping segments of D 
samples each so that DP < M. Correlogram estimates of the auto- and cross power spectra 
S'l,, between the responses ο, o = 1, · · ■, Nmil, and a subset of reference responses

/ = 1 ,···,# , can be obtained using equations (3.8) and (3.9) for each segments s, 

s = 0,···,/>-1. An averaged correlogram estimate of the auto- and cross power spectra is then 
given by
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(3.12)
ρ-ι

It should be noted that averaging the correlogram estimates decreases the spectral resolution of 
the resulting estimate. Reducing the number of samples used for the computation of the 
correlation functions also increases the bias error due to leakage on these estimates.

3.3.3 The ‘positive’ power spectra approach

For the identification of modal parameters from output-only measurements, several frequency- 
domain identification methods are based on the cross power spectral densities satisfying (3.4). 
However, this technique has several disadvantages:

• The power spectra have a 4-quadrant symmetry i.e. the modal model contains as poles 
the values Ar, A*, -Ar and -A*. This results in a model order, which is twice the

modal order needed to model FRFs. For all identification methods based on the full 
spectra, this higher model order results in an increasing calculation time and in a less 
good numerical conditioning.

• The power spectra contain both stable Ar , A* and unstable poles -Af , -A* poles in its

model. This results in less interesting properties for the interpretation of stabilization 
diagrams, when distinguishing physical from mathematical poles.

• Power spectra estimated from a limited amount of data are typically characterized by high 
noise levels compared to FRFs. Therefore, an additional noise reduction would be 
preferable.

• When using the periodogram approach to estimate the power spectra, a tradeoff must be 
made between the stochastic uncertainties and the bias errors introduced by leakage.

Some of these disadvantages can be overcome by starting from the first M positive lags of the 
correlation function Rn given by (3.8). Using the correlogram approach it is sufficient to estimate

the so called positive spectra (or half spectra), which are obtained by using only the correlation 
having a positive time lag (Cauberghe 2004, Peeters and Van der Auwearer 2005) in (3.9) as 
follows

The modal decomposition of these half spectra only consists of the first two terms in (3.4), that is,

The relation between half spectra (3.13) and the full spectra (3.9) is the following:
*r

(3.14)

N,
Erg[ \Lrg

•T

(3.15)
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The advantage in modal analysis is that models of low order can be fitted without affecting the 
quality.

Under the white noise input assumption, the output correlations are equivalent to impulse 
response. So, just like in impact testing, it is logical to apply an exponential window W(k) to the
correlations before computing the DFT in equation (3.13). The exponential window reduces the 
effect of leakage and the influence of the higher time lags, which have a larger variance. 
Moreover, the application of an exponential window to impulse responses or correlations is 
compatible with the modal model and the pole estimates can be corrected using equation (3.11).

3.3.4 Choosing reference responses

Similar to choosing position(s) for the input force(s) (so-called references) during input-output 
modal testing, the choice of good reference response signals during output-only modal testing 
can be important for obtaining high quality data sets.

If all Nout responses of a structure under test are measured simultaneously, each of the 

structural responses can be used as a reference response. This approach results in a Nolll x Nm 
power spectrum matrix S(ja>). If the number of outputs is large, the latter approach can lead to 
a high computational burden especially during the parametric estimation.

Instead of using all outputs as reference responses, a small number of responses in suitable 
locations of the structure can be chosen as reference responses. Note that the nodal points of 
structural modes should be avoided to be used as reference positions. Moreover, responses with 
a signal to noise ratio superior (or at least equal) compared to the other responses should be 
preferred when choosing reference responses in order to increase the quality of the auto and 
cross power spectral density estimates. If the reference response signals are chosen carefully, 
similar quality modal information can be extracted from data sets obtained with a limited number 
of references as from data sets where the maximum number of references was used.

The idea of the reference sensors can be used to obtain measurements for a structure using a 
small number of sensors compared to the measurement locations that one would like to identify 
the modeshape components. In this case the available sensors are divided into two groups. One 
group constitutes the reference group and the sensors are placed at reference locations which 
remain fixed during the measurements. The other group constitutes the moving group and the 
sensors in this group are moved from measurement to measurement to new locations until all 
desirable measurements locations are covered by the available number of moving sensors. The 
measurements from the moving sensors are combined into the vector x(m), while the

measurements from the reference sensors constitute the vector of measurements xref (m). In 

choosing the reference locations care should be taken so that nodal points are avoided.

26

Institutional Repository - Library & Information Centre - University of Thessaly
23/05/2023 01:59:53 EEST - 3.236.241.27



Appendix 3.A: Modal decomposition of cross power spectral 
density functions
The aim of this appendix is to show that the cross power matrix of the responses 4,(4») can 

be modally decomposed in the form (3.4). For this, note that equation (2.99) can written as

H(jco) = [U £/*] 

where U , Lc are given by , (2.78) and (2.101)

Kjco) =

44») 0
0 h'ijeo)

4» “4

h'(jco) =
jo-sl,.

0

Substituting equation (3.16) in (3.3) gives

44») 0
0 h\jco)

Sxx{jco) = [u U'] 4
4

4
4

eC"

e C"

s.[4r 4]

(3.16)

(3.17)

(3.18)

4 44») 0
0 4“4»)

U'T

UT
(3.19)

It should be noted that each component in the matrix S^jo)) is a product of the four rational 

functions

1 1 1
and

1
]ω-/ir jco - Λ - jco - λν -jco-λ,.

(3.20)

So partial fraction decomposition can be used to write each component of Sxx(j<v) as a sum of 

the rational functions (3.20) with coefficients in the sum to be determined.

Repeating this partial fraction decomposition for all components of the matrix Sxx(jco), one 
finally has the following partial fraction decomposition for the cross power spectral density matrix

4.v(4y):

4,(4») = Σ
r=\

Ψ.
jco-λ,.

- + Ψ rl jCD-λ,7 + 4 3

1
-jo-λ,.

■+Ψ
1

r 4 -]ω-λΓ
(3.21)

where Ψ„ e CΛ","><Λ'"," are the matrix coefficients to be determined as follows.
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Specifically, the matrix Ψγ1 is obtained by multiplying both sides of equation (3.21) by jco- Ar 

and evaluating the resulting equation at /&> = Ar. Thus, one obtains that

ΨΓΐ=α<»-4.)5„0·ω) =

[u u·]
0h(jo))(jco-Ar) '4' s0 Γ r; 4] '4 (-4) o ~u*r

(

0 C
l

δ̂ C δ 1 C
1__

__ A.
o t c j 0 h(-l)_ uT _

(3.22)

This expression is further simplified by noting that

[ϋω-λΓ)Κ]ώ)\ω=κ eR“"' (3.23)

and

(3.24)

where e R",xl is a vector with the r -th element equal to 1 and all other m — 1 element equal 
to 0 . Thus, the following expressions are simplified to

h(jco) 0[u u·]
0 h (Ja>)

= [0 ··· 0 u. 0

' A A o’(j(o-Ar) = [[/ u]
JQ>=\ 1-- c c

0] e CN„.„x2 m

and

[u u·] h(ja>) 0 

0 h\j(o) (J&-A)
4

r
L -IJ/a>=Ar

= [o ··· o u,. o ··· o]

Substituting in (3.22) gives

ψ,,=*αΓ$>[c 4]

4
4

= iti eCN„„,x2m

h\-K) 0
0 h(—Ar)

Introducing the vector

g)=/X[C 4]

the coefficient matrix simplifies to

h\-Ar) 0
0 h(-Ar)

'VrX-UrgI

U'T

UT

U'T~

ur

g (βΝ<Μ*Ν<Μ

eC 1 xNm

(3.25)

(3.26)

(3.27)

(3.28)

(3.29)
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Similarly, multiplying both sides of equation (3.21) by ja>- Xr and evaluating the expression at 

yry = λ* one obtains that

Ψ,2 =(Jm-K)s„(j<») =

\u u' 1 h(Ja>Xje>-£) 4" s0\l‘ct 4] 4 (-4) 0 Vr"
L J o 4(/6>)(/ft>-4) .4,

0 L c 1 J
0 Λ(-4).

ta=K

This expression is further simplified by noting that

[ο-ι;»;®)] = Osir”

and

The following simplification follows

(3.30)

(3.31)

(3.32)

ΛΟ'ω) 0
Ο'ω-4) "4" =14/ t4l ‘0 0 "4"

0 4(yry)_ .4.
L J

,/ω=Λ*
_° s,£ _ .4.

h\~K) 0
0 h{-K)

[u V]

= [o ··· 0 £ 0 ··· o]

Substituting in (3.30), one obtains that

4]

Introducing the vector

4]

then

4
4

(3.33)
*T _ mN„„,x2m= uj eC

't/*r

t/r
6 C (3.34)

4 (-4) 0

0 m-4)

*yu 
u7

eC lxJV„

IT/ *

^ rl ~ IL P r

(3.35)

(3.36)

Proposition: The following equation holds which relates the vectors p and g involved in 

equations (3.29) and (3.36)

Pr =£ (3.37)

Proof: Starting from the definition of p in (3.35), one has that
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p!=Cts„[l]t 4]
h*{-A'r)U'T' 

h (-λl)UT
= Cso{i:jh\-Xr)U'T +LTch (-Λl)UT} (3.38)

Also, starting from the definition of g in (3.29), one has that

£ =£X[4 r;] u
[A'HU] 0 [ 6"

0 [Λ(-Ί,)]

[A'(-A,)]‘i/r 

L[h(-Xr)iu'T _

=C!sAltc [tH)J c/r+C [a (-4)]' cr

='Js„[4 4r] (3.39)

Note that the above equation assumes that = So which is true for the case of the excitation 

vector is a superposition of independent white noise processes.

Using (3.18) for ]ω = -λΓ one has that

h\~K) =

0

-A -A

and taking the complex conjugate, one derives that

[a'm,)]'- -A - A

Using (3.17) for jco = -Xr, it can be seen that

[ti(-Xri[=h (-A*)

(3.40)

(3.41)

(3.42)

Using (3.17) for ja> = —A , one has that

h(~ A) = -A - A

and taking the complex conjugate, one derives that

(3.43)

30

Institutional Repository - Library & Information Centre - University of Thessaly
23/05/2023 01:59:53 EEST - 3.236.241.27



[> <-Λ)]' =
-Λ* - λ'

Using (3.18) for ja> = —Λ* it can be seen that

[h (-/Lr)J =h\-A'r)

(3.44)

(3.45)

Substituting (3.42) and (3.45) into (3.39) one readily derives that the right hand side of (3.39) is 
the same with the right hand side of (3.38) and thus

P =g' (3.46)_—r —r

which completes the proof of the proposition.

Using (3.36) and (3.37) one has

xi,r2=^£' (3.47)

Moreover, comparing with (3.36) one has that

Ψ,2=Ψ*Γ1 (3.48)

Similarly, the matrix Ψ(,3 is obtained by multiplying both sides of equation (3.21) by (-/ω-λΓ) 

and evaluating the resulting equation at yTy = -A,.. Thus one obtains that

ΨΓ,=Ηω-λΓ)ΞχχΟω) =

\p "·]

0
Kjω)(-]ω-λΓ) X S0 Γ L[T LTC1

~h\Xr) 0 ~U'T~

0 ti(jo)){-jo)-Xr) A.
υ L ‘ c J 0 h(Xr)_ ur _

(3.49)

This expression is further simplified by noting that

[(-;<»- ·*>'(-»],„_* = o s R”

and

[Πω-νΗΟω)]^ eM"

(3.50)

(3.51)

Thus, the following expression is obtained
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(3.52)
T]

=[

h\jo)) Ο 

Ο h (jco )

Ο Ο ι Ο

(-]ω-λΓ) 

■·· 0]

(7*Γ

Τ/7'

τ"£/

t/r
=/,«; € cN,„„x2m

Substituting in (3.49) gives

Ψ„3=[£/ f/*]
K~A) 0 Lc

ο λ*μγ)1ι; 6 C
ΟΙ// ' ΟΙ// (3.53)

and taking the complex conjugate transpose of equation (3.35) one has

£=[u u·] M-A) o 
o tiirX,) LL c J

Sol (3.54)

that can be substituted in equation (3.53) to give

Ψ,3=ρΧ (3·55)

Using equation (3.37), one has

ΨΓ3=£γ«γΓ (356)

Similarly, multiplying both sides of equation (3.21) by — y'/y-Λ* and evaluating the expression at 

y/y = —A* one obtains that

ψγ4=(->-Λ*)5„0®) =

rt/ c/Ί
Kjo))(-joj~A) V S0 Γ L'J LTC] ~h\K) 0 ~u'T~

L J 0 h‘ (j(0){-j(0-A) L'L c _ 0 L ‘ 1 J 0 KK). UT _

ja>=-£ (3.57)

This expression is further simplified by noting that

= δ δτ e R",x'" 
-r-r

(3.58)

and

[(-7® - K )h . = 0 e R"'xm
ΐω=-λ.

(3.59)

The following simplification follows
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(3.60)

h'(-jeo)

0
0

h (~]ω)

'U'T~
(-]ω-λΓ)

UT _

=[o - o C
U‘T

UT

* *
= p ur eCNn„,x2m

Substituting in (3.57) gives

Vr*=\U IT]
Κ-λΓ) 0

0 h\-K)
4
r S0£urT e CN-*N- (3.61)

and taking the complex conjugate transpose of equation (3.28) one has

£=[{/ £/·] K-K) o 
o 4 (-4)

4
4 Sol (3.62)

that can be substituted in equation (3.61) giving

Ψ,4 =£ΛΓ (363)

Finally, substituting the expressions (3.29), (3.47), (3.56) and (3.63) for the matrices ΨΗ, Ψλ2, 

Ψγ3 and Ψγ4, respectively, into equation (3.21) results in the final form for Sn(jco) given in 

(3.4) with g‘ given by (3.28).
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Chapter 4

Least squares output error methodologies for modal 
identification

4.1 Introduction
This chapter discusses several Modal Identification methodologies proposed to estimate the 
modal properties for the cases of EMA, OMA and earthquake induced vibrations. Modal 
identification methodologies are used for the estimation of modal frequencies, modal damping 
ratios, modeshapes and modal participation factors of a structure. All these methodologies 
introduced are based on the minimization of an output error function using a least squares 
minimization approach. The formulation is presented for the general case of non-classically 
damped modal model.

Specifically, the proposed modal identification methodologies use a three step approach to solve 
the error minimization problem. The first step provides estimates of the modal frequencies and 
modal damping ratios by solving a system of linear algebraic equations using the right-matrix 
fraction model or the common denominator model (Verboten 2002; Cauberghe 2004). 
Stabilization diagrams are used to distinguish between physical and mathematical modes. For the 
cases of OMA and ΜΙΜΟ this method (first step) is an extension of the PolyMAX or polyreference 
least-squares complex frequency domain method, developed by Peeters et al. (2004). The 
second step provides estimates of the modeshapes and the participation factors by solving a 
system of linear algebraic equations. It should be noted that two different approaches have been 
developed for the computation of the modeshapes and participation factors in this second step. In 
the first approach the modal properties are derived directly by Singular Value Decomposition 
(SVD) of the resulting numerator matrix. In the second approach, advantages taken from the fact 
that the error function is quadratic with respect to the modeshapes. So the modeshapes are 
computed by taking stationary conditions in order to develop a linear system of equations from 
which the modeshapes are derived. The first two steps usually give accurate estimates of the 
modal characteristics. However, a third step is often recommended to improve these estimates, 
especially for closely spaced and overlapping modes, by efficiently solving the full nonlinear 
optimization problem with initial estimates of the modal parameters those obtained from the first 
and second steps. A schematic diagram summarizing this three step modal identification 
algorithm is presented in Figure 4.1.

This chapter is organized as follows. Section 4.2 describes the identification methodology for the 
case of EMA. In the next Section 4.3 the identification methodologies for OMA are discussed for 
the cases involving the Full and the Half spectra functions. The case of modal identification based 
on earthquake induced (base excitation) vibrations is presented in the time and frequency domain 
in Section 4.4. Finally, a modal identification example using simulated ambient vibration 
measurements is presented for the case of a structure with closely and overlapping modes 
showing the efficiency of the proposed three step identification approach.
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4.2 Experimental Modal Analysis
The estimation of the modal characteristics using vibration data induced by a measured force 
applied on a structure is based on a least squares minimization of the measure of fit

k=\ L
E(6) = ^tr (H(kAco;0)-H(kAco)^ ^H(kAco,([)-H(kAco)^ (4.1)

between the Frequency Response Function (FRF) matrix H(kAo)) e CN"*N,n estimated from the 
measured output acceleration time histories and the FRF matrix H{kAa>;0) e CN,’xN‘" predicted 
by a modal model, where N0 is the number of measured DOFs, Nm is th number of excited 

DOFs, Αω is the discretization step in the frequency domain, k = {1,···,Λ^ω} is the index set 

corresponding to frequency values ω = kAco , Νω is the number of data in the indexed set, and 
Θ is the parameter set to be estimated. Assuming general non-classically damped modes, the 
FRF matrix H(kAa;B) based on the modal model of the structure is given by (2.99) written 
alternatively as

Η(]ω,θ)
r=\

u.l.
■ + -

* ,*r
UJ-r

jo - λΓ ]ω - λΓ
+ A + -

B

UcoY
(4.2)

where m is the number of contributing modes in the frequency range of interest,

is the complex eigenvalue of the r -th contributing mode, cor is the 

r-th modal frequency, ζΓ is the r-th modal damping ratio, ur e C'v° is the complex modeshape

of the r-th mode, A e ΜΛ°χΛ/'" i Be RiV°xA/'" are real symmetric matrices called the upper and 
lower residual terms accounting for the approximate contribution of the out-of-bound modes to the 
selected frequency range of interest (Heylen et al. 1997), and /,. e C^'" are the participation 

factors, while the symbol z* denotes the complex conjugate of a complex number z .

The modal parameter set Θ to be identified contains the parameters a>r, ζΓ, ur, l_r, 
r = 1, —,m , A and B that completely define the FRF matrix in eq. (4.2). The total number of 

parameters is 2m(\ + 2N0) + + N0 for non-classically damped modal models.

A three step approach is used to identify the number of contributing modes and to estimate the 
values of the modal properties given the FRF H(kA(o) estimated from the measured input- 
output response time histories. In the first step, conventional least squares complex frequency 
algorithms using the right matrix fraction polynomial model (Verboten 2002; Cauberghe 2004) are 
employed, along with stabilization diagrams, to obtain estimates of the modal frequencies ωΓ,

modal damping ratios ζΓ and participation factors l_r, as well as distinguish between the physical

and the mathematical modes. In the second step by recognizing that the error function in (4.1) is 
quadratic with respect to the complex modeshapes ur and the elements in the matrices A and

B explicit expressions that relate the parameters ur, A and B to the vectors l_r, the modal 
frequencies a>r and the damping ratios ζΓ are obtained. These values in most cases are very
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close to the optimal values. Alternatively, in the second step, given the values of cor and ζΓ, the 

values of the residue matrices Rr =uj.l,1 e Cw°* in eq. (4.2) are obtained by first recognizing 
that the objective function in (4.1) is quadratic with respect to Rr, A and B , then formulating 

and solving the resulting linear system of equations for Rr, A and B, and finally applying SVD 

to obtain estimates of ur and l_r from Rr. Usually, this two-step approach gives results that are

very close to the optimal estimates. However, for closely-spaced and overlapping modes it is 
often recommended to solve the original nonlinear optimization problem with objective function 
given by (4.1).

In the third step, the minimization of the objective function (4.1) can be carried out efficiently, 
significantly reducing the computational cost, by recognizing that the error function in (4.1) is 
quadratic with respect to the complex modeshapes ur and the elements in the matrices A and 
B. This observation is used to develop explicit expressions that relate the parameters ur, A 

and B to the vectors l_r, the modal frequencies ωΓ and the damping ratios ζΓ, so that the 

number of parameters involved in the optimization is reduced from 2m(\ + 2N0) + to 

2m(N0 +1). This reduction is considerable for a relatively large number of measurement points. 

Applying the optimality conditions in eq. (4.1) with respect to the components of ur, A and B , a 

linear system of equations results for obtaining ur, A and B with respect to the l_r, cor and ζΓ, 
r = 1, . The resulting nonlinear optimization problem with respect to the remaining variables

l_r, cor and ζΓ, r = is solved in Matlab using available gradient-based optimisation

algorithms. The starting values of the parameters required in the optimization are obtained from 
the estimates provided by the first and second steps. These starting values are usually very close 
to the optimal values for most of the modes and thus the optimization algorithm converges in a 
relatively few iterations.

4.3 Operational Modal Analysis
In this case, the input measurements are not known. They are assumed to be modeled by white 
noise processes. The modal identification is based on either the full or the half spectra as follows.

4.3.1 Identification based on the full spectra

The estimation of the modai characteristics using vibration data induced by ambient unknown 
excitation forces applied on a structure Is based on a least squares minimization of the measure
rkt ίϊ*

*T \ ~
Ε{θ) = Σ<ν (SikAco-'tD-SikAa))} (S(kAor,i)~S(kAa)J

k=1 L
(4.3)

between the Cross Power Spectral Density (CPSD) function matrix S(kAco) e CN"*N" estimated
nsinn thp tpr.hnjniips dpsrrihpri in Chpntpr λ from thp mppsurpri outnut pr.r.plpration timp historips
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and the CPSD fraction matrix S(kAco,ff) e CN°xN° predicted by a modal model, where N0 is the 
number of measured DOFs, Aco is the discretization step in the frequency domain, 
k = {1,···, is the index set corresponding to frequency values ω - kAco , Na is the number 
of data in the indexed set, and # is the parameter set to be estimate. Assuming general non- 
classically damped modes, the CPSD function matrix S(kAtο,θ) based on the modal model of 
the structure is given by (3.4), written alternatively as

®<μ©=Σ
t * *T

Hr8„ Hr 8
■ +-----=TT +

8rHr
- + -

8K

r=1 j<o-K j<°-K -)ω~Κ (ja)
(4.4)

where m is the number of contributing modes in the frequency range of interest, 

A =-4>r±M>/i-C2 is the complex eigenvalue of the r -th contributing mode, a>r is the 

r -th modal frequency, ζΓ is the r -th modal damping ratio, ur e C^0 is the complex modeshape

of the r -th mode, A e K'v<|XA/°, B e KA°xAfn are real symmetric matrices called the upper and 
lower residual term accounting for the approximate contribution of the out-of-bound modes to the 
selected frequency range of interest (Heylen et al. 1997), and gr eCN° are vector quantities

called operational reference vector given in Chapter 3, that depend on the characteristics of the 
modal model and the CPSD of the white noise input vector, while the symbol z denotes the 
complex conjugate of a complex number z .

The modal parameter set Θ to be identified contains the parameters cor, ζΓ, ur, gr, 

r = l,--,m, A and B that completely define the CPSD fraction matrix in eq. (4.4). The total 

number of parameters is 2m(\ + 2N0) + Nl + N0 for non-classically damped modal models.

A three step approach is used to identify the number of contributing modes and to estimate the 
values of the modal properties given the CPSD functions S(kAco) estimated from the measured 
output response time histories. In the first step, conventional least squares complex frequency 
algorithms using the common denominator model (Verboten 2002) are employed, along with 
stabilization diagrams, to obtain estimates of the modal frequencies o)r and modal damping

ratios ζΓ as well as distinguish between the physical and the mathematical modes. In the second

step by recognizing that the error function in (4.3) is quadratic with respect to the complex 
modeshapes ur and the elements in the matrices A and B explicit expressions that relate the

parameters ur, A and B to the vectors gr, the modal frequencies a>r and the damping ratios 

ζΓ are obtained. These values in most cases are very close to the optimal values. Alternatively, 

in the second step, given the values of oor and ζΓ, the values of the residue matrices 

R, ~ Hr8r e CN“*No in eq. (4.4) are obtained by first recognizing that the objective function in 

(4.1) is quadratic with respect to Rr, A and B , then formulating and solving the resulting linear 

system of equations for Rr, A and B , and finally applying SVD to obtain estimates of ur and 

gr from Rr. Usually, this two-step approach gives results that are very close to the optimal
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estimates. However, for closely-spaced and overlapping modes it is often recommended to solve 
the original nonlinear optimization problem with objective function given by (4.3).

The minimization of the objective function (4.3) can be carried out efficiently, significantly 
reducing the computational cost, by recognizing that the error function in (4.3) is quadratic with 
respect to the complex modeshapes ur and the elements in the matrices A and B. This
observation is used to develop explicit expressions that relate the parameters ur, A and B to 

the vectors gr, the modal frequencies cor and the damping ratios ζΓ, so that the number of 

parameters involved in the optimization is reduced from 2m(\ + 2N0) + Nl + N0 to 2m(N0 +1).

This reduction is considerable for a relatively large number of measurement points. Applying the 
optimality conditions in eq. (4.3) with respect to the components of ur, A and B, a linear

system of equations results for obtaining i±r, A and B with respect to the gr, a>r and ζΓ, 

r = l,···,m . The resulting nonlinear optimization problem with respect to the remaining variables 

gr, cor and ζΓ, r = is solved in Matlab using available gradient-based optimisation

algorithms. The starting values of the parameters required in the optimization are obtained from 
the estimates provided by the first and second steps. These starting values are usually very close 
to the optimal values for most of the modes and thus the optimization algorithm converges in a 
relatively few iterations.

4.3.2 Identification based on the half spectra

In the previous section the estimation of the modal characteristics using vibration data induced by 
ambient unknown excitation forces applied on a structure was based on a methodology that use 
the CPSD functions of the measured response signals. In this section the modal identification 
methodology is based on a similar approach but using the half CPSD functions (or half positive
spectra) of the measured response signals. This approach is presented in the work by Peeters 
and Van Auweraer (2005). Specifically, the methodology is based on a least squares
minimization of the measure of fit

£(6>) = fV (S++(kAco:e)-S++{kAco))'' (S++(kAM-B)-S++(kAa)) 
*=i L

(4.5)

between the half spectra matrix S++(kAa>) e C'v"xΛ,|, estimated using the techniques described in 
Chapter 3 from the measured output acceleration time histories and the half spectra matrix 
S++(kAw;B) e CN"*N° predicted by a modal model, where N0 is the number of measured DOFs,

Αω is the discretization step in the frequency domain, k = {1,···,Na} is the index set 

corresponding to frequency values ω = kAco , Νω is the number of data in the indexed set, and 
Θ is the parameter set to be estimate. Assuming general non-classically damped modes, the half 

spectra matrix S++(kAa>;0) based on the modal model of the structure is given by (3.4) written 
alternatively as
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(4.6)s++(M0 Σ μ!
jo) - κ

+

* *γ

Erg,.
ja>~K

+ — + (jo)B 
JO)

where m is the number of contributing modes in the frequency range of interest, 

λΓ=-ζΓωΓ±]ω^\-ζ2Γ is the complex eigenvalue of the r -th contributing mode, a>r is the 

r -th modal frequency, ζΓ is the r -th modal damping ratio, ur e €Λ° is the complex modeshape

of the r -th mode, A e Μ'ν|Ι><ΛΓο i B e KA°xA/" are real symmetric matrices called the upper and 
lower residual term accounting for the approximate contribution of the out-of-bound modes to the 
selected frequency range of interest and gr e CN° are vector quantities called operational

reference vector given in Chapter 3, that depend on the characteristics of the modal model and 
the CPSD of the white noise input vector, while the symbol z denotes the complex conjugate of 
a complex number z .

The modal parameter set Θ to be identified contains the parameters cor, ζκ, ur, gr, 

r = l, ■··,/«, A and B that completely define the half CPSD matrix in eq. (4.6). The total 

number of parameters is 2m(\ + 2N0) +1V02 for non-classically damped modal models.

Recognizing that (4.5) and (4.6) has exactly the same structure with (4.1) and (4.2) respectively, 
one can directly apply for this problem the same optimization procedure described in Section 
4.3.1. The only difference is in the coefficients A and B which can be readily taken into account 
in the formulation.

4.4 Earthquake induced vibrations
In this section, a time and a frequency domain methodology are presented for identifying the 
modal parameters of non-classically damped modal models used to describe the response of 
linear structures subjected to multiple base excitations. The modal parameters to be identified 
include the modal frequencies, the modal damping ratios, the modeshapes and the participation 
factors. The proposed structural modal identification methodology is applicable to civil 
engineering structures such as buildings, towers, bridges, offshore structures, etc., subjected to 
earthquake excitations. The identification methodology for the time domain methodology uses 
measured input acceleration time history data at the base DOFs and output acceleration time 
history data at several model DOFs of the structure. The identification methodology for the 
frequency domain methodology uses the Discrete Fourier Transform (DFT) of the measured input 
acceleration time history data at the base DOFs and the output acceleration time history data at 
the model DOFs of the structure. An output error formulation is presented, in which the modal 
parameters are identified through least-squares matching between the output measured 
responses and the responses predicted by a modal model of the structure subjected to the 
measured base inputs. All these methodologies have been described in full details in the thesis 
by Nikolaou (2008).

The methods developed by McVerry (1980) in the frequency domain and Beck and Jennings 
(1980) in the time domain have been extended to treat non-classically damped modal models,
since damping may not be proportionally distributed In various structural components, especially

40

Institutional Repository - Library & Information Centre - University of Thessaly
23/05/2023 01:59:53 EEST - 3.236.241.27



due to the energy dissipation mechanism provided locally by the elastomeric bearings and the 
foundation soil. The modal identification methodology also accounts for different support 
excitations encountered in civil engineering structures.

4.4.1 Identification in the time domain

Let y(kAt,e) be a vector of the sampled response of a linear structure obtained from a modal 

model involving a parameter set Θ and m modes. The variable At denotes the time 

discretization step and k - {1,2,...,N} is an index set and N the total number of sample data 

over the response duration T. The parameters in Θ include the modal characteristics such as
modal frequencies, modal damping ratios, and modeshape components at the measured 
locations, modal participation factors, and other parameters that completely define the response 
vector y(kAt.e).

A modal model output-error identification approach seeks the optimal values of the parameter set 
Θ that minimize a measure of fit between the modal model predictions y[kAt,6) and the

corresponding response y(kAt) estimated from the measured data. That is, the modal model 

identification is formulated as a minimization problem of finding the values of Θ that minimizes 
the measure of fit

•J(0)=^S[z(*A,;£)“i(*AO]r [y{kAt;0)-y{kAt)] (4.7)
f (t=0

where y(kAt) is the measured response time histories at the N0 measured DOF, y(kAt;0) is 
the response time histories at the measured N0 DOF predicted by the modal model.

The normalization factor for time domain is given by

^ = Σ[ϊ(*Δ/)]Γ [r(*Af)] (4.8)
*=0

Using the analysis in Chapter 2, the vector γ(ί:θ) of the acceleration responses at the 
measured degrees of freedom, based on the non-classically damped modal models, can be 
written in the form

y(t) = [u lf]m + Dcu(t) (4.9)

where Dc e ΜΛ,"χΛί"' is a real matrix, u{t) is the vector of the base excitation time histories 
measured at the Njn locations,

U = eCN-“' (4.10)

is the matrix of the complex eigenvectors ur, r = , at jV0 DOFs, and
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(4.11)

6(0

ξ{ί) 6.(0
£(0

£(0

eC2/;/χ1

is the complex vector of modal coordinates satisfying the complex modal state space equations

1(0 = ΑΙ(0+ι'α(ή y = 1 ffi
iXt)=Ki'AO+CTa.(t)

(4.12)

where fr e CUN‘" is the complex vector of the modal participation factors relating the Nm inputs 

to the r mode of the system, and

K = -ζ,-ω,· ± MV1_C2 = ~ar ± jbr ,r = l,...,m (4.13)

are the complex eigenvalues of the structure. The modal response ξΓ(ί) can be obtained by 

solving (4.12) using the complex-valued initial conditions £.(0).

The parameters set Θ in the notation y(t',0) contains the parameters that completely define the 
response vector y(t,(A) using the modal analysis. From equations (4.9) to (4.13), it is evident 
that the parameter set Θ contains the complex eigenvalue λΓ of the r mode, the complex 
modeshapes e CAo>il, the modal participation factor vectors l_'r e CUN'", the initial conditions 
£(0) = ξΐ, and the entries of the real matrix Dc e M'v"x'v"', that is

Θ. ^r,ur,fr ,ξ°Γ ,r = (4.14)

where m is the number of contributing modes which is also unknown in the modal identification 
process.

The minimization of the objective function (4.7) can be carried out efficiently, significantly 
reducing computational cost, by recognizing that the error function in (4.7) is quadratic with 
respect to the complex modeshapes w,. and the elements in the real matrix Dc. This observation

is used to develop explicit expressions that relate the parameters i£. and Dc to the rest of the 

model parameters appearing in the parameter set Θ.

This formulation is an extension to the non-classically damped modes of the time domain 
formulation developed by Beck (1978) assuming classically damped modes. Basically, the 
problem being solved is the one of minimizing the cost function J (Θ) in (4.7) with respect to the

parameters θ_. For this case, gradient-based optimization method is implemented that requires 
initial estimates for the parameters. It should also be noted that modal sweep approaches 
(Werner et al. 1987) are also implemented to improve the effectiveness of the proposed 
algorithm.
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4.4.2 Identification in the frequency domain

Let y(kAω,θ) be a vector of the sampled Fourier Transform of the response of a linear 

structure predicted from a modal model involving a parameter set Θ and m modes at K 

measured DOFs. The variable Αω denotes the frequency discretization step and 
k — {1,2,...,jVw} is an index set and Nω the total number of sample data over the response 

frequency band. The parameters in Θ include the modal characteristics such as modal 
frequencies, modal damping ratios and modeshape components at the measured locations, 
modal participation factors, and other parameters that completely define the response vector 
y(kALd,9_).

A modal model output-error identification approach seeks the optimal values of the parameter set 
Θ that minimize a measure of fit between the Fourier Transform of the acceleration y(kAu,(P)

predicted by the modal model of the structure and the Fourier Transform of the corresponding 
response acceleration estimated from the measured data. Thus, the output-error

measure J (0) between measurement data and model predictions that correspond to a certain 

value of £ , is described similar to (4.7) by

•/(2) = ^γΣ [£(*Δω,0)-£(*Δω)] T [^(ΛΔω,£)-^(^Δω)] (4.15)
' k=0

Where V is the normalization factor for time domain given by:

^ = Χ][τ(£Δω)] Γ[^(Α:Δα;)] (4.16)
k=0

The Fourier transform vector y(kAijj\ Θ) e CN° of the acceleration responses based on the non- 
classically damped modal model can be obtained in the form

y(M0)eCN° =
m

Σ
r=1

ui: * l*T
u..l

iM)-\ (M~\
+ P AM (4.17)

where the vector f(ju) contains the Fourier transforms of the input (base) acceleration time 

histories at the Nin locations and m is the number of contributing modes which is also unknown 

in the modal identification process.

The parameter set Θ to be identified contains the modal frequencies uir, the modal damping

ratios ζΓ, the complex modeshapes ur, the modal participation factor vectors l_r, r = l,···,m ,

and the constant matrix P which contains the pseudostatic response of the structure due to 
multiple differential base excitations. The total number of parameters is
2m(l + N0+Njn) + N0Njn for non-classically damped modal models. The formulation in eq.

(4.17) assumes that measured vibrations start from zero. Non-zero starting vibration levels have 
also been accounted for by adding additional terms in eq. (4.17) and augmenting the parameter 
set Θ to include parameters that account for the initial conditions of the modal equations.
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The optimal values of the parameter set θ_ are obtained by minimizing the objective function
(4.15). This procedure is accomplished by applying a three step approach similar with the cases 
of identification based on artificial and ambient induced vibrations. Specifically, in the first step, 
conventional least squares complex frequency algorithms using the common denominator model 
(Verboten 2002) are employed, along with stabilization diagrams, to obtain estimates of the 
modal frequencies a>r and modal damping ratios ζΓ as well as distinguish between the physical

and the mathematical modes. In the second step by recognizing that the error function in (4.15) is 
quadratic with respect to the complex modeshapes ur and the elements in the real matrix P

explicit expressions that relate the parameters and P to the vectors l_r, the modal 
frequencies a>r and the damping ratios ζΓ are obtained. These values in most cases are very 

close to the optimal values. Alternatively, in the second step, given the values of cor and ζΓ, the 

values of the residue matrices Rr = u^lj e CN"*N'" in eq. (4.17) are obtained by first recognizing 

that the objective function in (4.1) is quadratic with respect to Rr and P, then formulating and 

solving the resulting linear system of equations for Rr and P , and finally applying SVD to obtain 

estimates of ur and l_r from Rr. Usually, this two-step approach gives results that are very close

to the optimal estimates. However, for closely-spaced and overlapping modes it is often 
recommended to solve the original nonlinear optimization problem with objective function given 
by (4.15).

In the third step, the minimization of the objective function (4.15) can be carried out efficiently, 
significantly reducing the computational cost, by recognizing that the objective function in (4.15) is 
quadratic with respect to the complex modeshapes ur and the real matrix P. Applying the 
optimality conditions in eq. (4.15) with respect to the components of ur and P , a linear system 

of equations results for obtaining ur and P with respect to the vectors l_r, ur and (r. The 

resulting nonlinear optimization is reduced to the 2m(3 T- Nin) parameters l_r, ωΓ and ζΓ, 
r — . This reduction is considerable for a relatively large number of measurement points.
Applying the optimality conditions in eq. (4.15) with respect to the components of ur and P a 

linear system of equations results for obtaining ur and P with respect to the Lr ’ ®r and C 
r = 1,· · ■, m . The resulting nonlinear optimization problem with respect to the remaining variables 

/r, cor and ζΓ, r = is solved in Matlab using available gradient-based optimisation

algorithms. The starting values of the parameters required in the optimization are obtained from 
the estimates provided by the first and second steps. These starting values are usually very close 
to the optimal values for most of the modes and thus the optimization algorithm converges in a 
relatively few iterations. The derivatives of the objective function with respect to the modal 
parameters are evaluated analytically, accelerating the convergence of the algorithm. Modal 
sweep approaches (Werner et al. 1987) are also implemented to improve the effectiveness of the 
proposed algorithm.
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4.5 Identification of closely spaced modes using simulated 
measurement data

The modal identification of a structure that has closely and overlapping modes is always a 
challenging problem. This problem is studied in this section in detail. Specifically, the proposed 
three step algorithm is applied and its efficiency is tested for the identification of closely spaced 
modes using simulated measurement data of the response of a model structure. In the literature, 
the usage of two step algorithms is commonly used for modal identification. This example 
demonstrates that the first two identification steps are sometimes inadequate especially for the 
case of closely and overlapping modes. For this case the application of the third step is 
necessary and is shown to improve significantly the modal identification results.

A model of a two-span bridge-like structure, shown in Figure 4.2, is considered in the simulation 
studies. The two spans are weakly connected and almost similar in properties. This has an effect 
of having two very closely bending modes. The behavior of the two span bridge resembles the 
behavior observed for the four span G2 Kavala bridge of Egnatia Odos Motorway. The four-span 
Kavala bridge has four closely spaced bending modes due to the almost similar properties of the 
four spans and the fact that these spans are weakly connected with each other. A finite element 
model for the simulated two-span bridge is constructed. The simulated measurement data used 
for the modal identification are the vibration responses predicted at several locations by a finite 
element model of a structure. These vibrations are induced by excitation forces applied at the 
deck and modeled by white noise processes. The model of the structure has been properly 
selected to have closely spaced and overlapping modes.

E E << E E

L *j- AL t· L

ΔΙ_« L

Figure 4.2: Two-span model of a bridge-like structure.

In generating the simulated acceleration response time signals to be used for identification using 
OMA, it should be noted that in order to clearly identify the closely spaced modes, the time 
duration of these responses should be several times greater than (2πIΔω), where Αω is the
distance between the modal frequencies of the closely spaced modes. It is expected that the 
larger the duration of the measured response in relation to (2π / Αω), the better the estimates of
the closely spaced modal properties. As the duration is increased, the measurements tend to 
contain the necessary information for the distinction of the closely and overlapped modes.
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The CPSD function matrix of the acceleration response of the model are first estimated using the 
methodologies described in Chapter 3 and then the first two steps of the proposed identification 
algorithm described in Section 4.3.1 are applied in the frequency band that contain the closely 
spaced modes for identifying the modal properties ωΓ, ζΓ, ur, gr, A and B that define the

CPSD matrix. The third step of the algorithm is also applied, where the original non-linear 
optimization problem (4.3) is solved with respect to the parameters ωΓ, ζΓ and gr, using as

initial values for the minimization (gradient based) algorithm the values of the parameters already 
computed by the first two steps of the identification algorithm. Figure 4.3 shows the comparison
between the absolute value S(kAo)) of the measured CPSD functions and the absolute value

|5(ΑΔ®;0)| of the CPSD functions predicted by the identified modal model for two

measurement DOFs. Comparisons are shown for the case of applying the first two steps of the 
algorithm and for the case of applying all three steps. In this figure it can be easily observed that 
the modal model identified by applying only the first two steps of the algorithm is quite inadequate 
compared with the modal model resulted when the third step is also applied.

Figure 4.3: Comparison between the measured CPSD function and the CPSD functions predicted by the 
modal model that was identified by applying the two step and the three step algorithms for two measurement

locations

The previous results were obtained for a duration of the response equal to α(2π / Αω), where a 
is chosen to be a = 100. In order to study the effect of the duration on the reliability of the 
estimates, the results are repeated for a duration 2α(2π I Αω) which is twice as much the 
previous duration. Comparisons are shown in Figure 4.4. An improvement of the fit is observed 
for the three step approach, while significant discrepancies are still evident between the 
measured and the model predicted CPSD using the two step approach.

It should be noted that signals with large durations may cause other problems concerning with the 
storage requirements and the transfer of the measured data. They also increase significantly the 
computational time for estimating the CPSD functions from the measured time response.
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Figure 4.4: Comparison between the measured CPSD function and the CPSD functions predicted by the 
modal model that was identified by applying the two step and the three step algorithms for two measurement 

locations (duration of response is twice the duration used in the results shown in Figure 4.3)
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Chapter 5

Applications on input-output and output-only modal 
identification

5.1 Introduction
In the present study, the modal identification methodologies and software developed are used to 
analyze the dynamic modal characteristics of structures using real dynamic data. The purpose of 
this chapter is to demonstrate and compare the applicability and effectiveness the modal 
identification methodologies by applying them for estimating the dynamic modal characteristics of 
a small scale laboratory structure using artificially (impulse hammer) excited vibration 
measurements and of three bridges of the Egnatia Odos motorway, using both ambient and 
earthquake induced vibration measurements.

The chapter is organized as follows. The modal identification methodology is first applied on a 
three-story small laboratory structure using artificially excited vibration measurements is 
presented in Section 5.2. In Section 5.3 the proposed ambient identification methodologies are 
applied to the under construction R/C bridge of Egnatia Odos at Metsovo using ambient vibration 
measurements. Finally, in Section 5.4 the proposed identification methodologies are also applied 
to two representative R/C bridges of Egnatia Odos, the first at Kavala using ambient vibration 
measurements and the second at Polymylos using ambient vibration measurements and vibration 
measurements for the low level, magnitude M, = 4.6, earthquake event that occurred on

21/2/2007 (2:04:38 GMT) at a distance 35km Northeast of the bridge.

5.2 Application on a three-story laboratory structure
This section applies the developed modal identification methodologies for estimating the dynamic 
modal characteristics of a three-story small laboratory structure using artificially excited vibration 
measurements. The structure was built and tested in the System Dynamics Laboratory of the 
University of Thessaly. The experimental modal identification methodology applied was that of 
Single-Input Multiple-Output (SIMO) described in Section 4.2. The identification of modes is 
based on the fit between the measured and the modal model predicted Frequency Response 
Functions (FRF).

5.2.1 Description of the laboratory three-story structure and instrumentation

The three-story laboratory structure is composed by three identical one-story components made 
of aluminum elements bonded with steel elements. A picture of the front view and side view of the 
fully composed three-story laboratory structure are given in Figure 5.1. A schematic diagram of 
the side and the front views of the individual (one-story) components of the laboratory structure 
with the material and geometric properties are given in Figure 5.2.
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(a) (b)
Figure 5.1: Three-story laboratory structure, (a) front view, (b) side view

l,

Aluminum

Steel

y X

Figure 5.2: Schematic diagram of individual structure component
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Modal identification results are presented for the case of artificially induced vibration data, 
generated by hitting the structure with an impulse hammer and recording the acceleration time 
histories and the excitation force. The recorded data for the structure include data sets obtained 
using an array of six accelerometers and the force transducer on the impulse hammer.

The experiment was conducted for the purpose of a case study for predicting the dynamic 
response of the whole three-story structure using finite element models by analysing the 
response of the separate structural components of the structure. Specifically, the modal 
identification methodology was applied for the separate parts of the structure. Three data sets for 
three different states of the structure respectively were available. The first data set contained the 
measurements for the one-story structure, the second data set contained the measurements for 
the two-story structure and the third data set contained the measurements for the whole three- 
story structure as shown in Figure 5.3(a). Sensor locations have been chosen in such a way so 
as to gather as more information as possible about the structure’s modal response. Appling the 
array of sensors shown in Figure 5.3(b) all major modeshapes along the strong direction (y axis)
can be identified using the developed modal analysis methodology. Figure 5.4 shows one 
indicative acceleration time history, from 0 to 20 seconds, obtained from sensor 1 measuring 
along y (strong) direction during a hammer test experiment, for the tree-story structure.

f
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(a)

Figure 5.3: Three-story laboratory structure, (a) different states of the structure, (b) sensor locations
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Figure 5.4: Measured acceleration timehistory from sensor 1 for the case of the tree-story structure

5.2.2 Modal identification results

Using the six available acceleration sensors which monitor the artificially induced vibrations and 
the measurement of the applied impulse force the Frequency Response Functions of the 
measured DOFs are evaluated. These Frequency Response Functions are evaluated by the 
MITooL software that is used for the estimation of the modal properties. The values of the modal 
frequencies, modal damping ratios, modeshape components and modal participation factors 
resulted from Stabilization Diagrams after distinguishing the physical from the mathematical 
poles. Figure 5.5 presents an indicative Stabilization Diagram evaluated for the case of the first 
data set containing measurements for one-story structure in the 0 to 140 Hz frequency 
bandwidth.

Figure 5.5: Stabilization Diagram for the case of one-story structure measurements

51

Institutional Repository - Library & Information Centre - University of Thessaly
23/05/2023 01:59:53 EEST - 3.236.241.27



The values of the modal characteristics (modal frequencies, modal damping ratios and modal 
participation factors) resulted from the Stabilization Diagrams are used for the estimation of the 
modeshape components using the second step of the algorithm described in Section 4.2. Finally, 
the fit between the measured and the estimated modal model predicted FRFs is improved by 
evaluating the third step of the algorithm described in Section 4.2 using the estimates of the first 
two steps as starting values for the optimization algorithm. Table 5.1 presents the modal 
identification results for all three vibration data sets corresponding to the one-, two- and three- 
story structures. Figure 5.6 and 5.7 compares the measured FRFs with the FRFs predicted by the 
identified optimal modal models for selected sensors and for the case of the three-story structure. 
As it is seen, the fit of the measured FRF is very good which validates the effectiveness of the 
proposed modal identification software.

Table 5.1: Modal identification results (modal frequencies and modal damping ratios) for the three-story
structure

No Mode Modefrequency
(Hz)

Damping Ratio 
(%)

One-story structure
1 1st Bending 9.1075 0.247%
2 1 ®* Rotational 54.3350 0.218%
3 2nd Bending 111.5299 0.883%
4 3rd Bending 319.8724 0.865%

Two-story structure
1 1st Bending 2.6636 0.108%
2 2nd Bending 15.8865 0.463%
3 1st Rotational 31.3313 0.293%
4 2nd Rotational 78.2356 0.170%
5 3rd Bending 82.7008 0.656%
6 4th Bending 149.6037 0.479%
7 5th Bending 284.0000 0.378%

Three-story structure
1 1st Bending 1.1353 0.024%
2 2nd Bending 7.6409 0.465%
3 3rd Bending 20.6040 0.412%
4 1st Rotational 21.7205 0.412%
5 2nd Rotational 59.9910 0.346%
6 4th Bending 74.6917 0.572%
7 3rd Rotational 84.2906 0.280%
8 5th Bending 114.0648 0.700%
9 6th Bending 155.1758 0.734%
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Figure 5.6: Comparison between measured at sensor 2 and optimal modal model predicted FRF

Figure 5.7: Comparison between measured at sensor 5 and optimal modal model predicted FRF

The modes identified were in the frequency band from 0 to 350 Hz. The modal damping ratios 
identified are significantly low varying according to Table 5.1 from 0.02% for the case of the three- 
story structure to 0.88% for the case of the one-story structure. For all the identified modes, the 
modeshape components at the measurement points were also estimated. For the case of one- 
story structure four modes were identified, three of them are bending modes and one rotational 
around the vertical axis (z axis). For the case of the two-story structure seven modes were 
identified, five of them are bending and two rotational modes. Finally, for the case of the three- 
story structure nine modes were identified, six of them are bending and three rotational modes. In 
Figures 5.8 to 5.16 graphical illustrations of the modeshape components for the first three 
identified modes are presented. The arrows are placed in measuring points and their length is 
proportional to the respective value of the normalized modal component. The modeshape 
components for each mode are compared with the corresponding modeshape predicted by the 
Finite Element (FE) models constructed for the three structures.
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Figure 5.8: Graphical illustration of the modeshape components for the first mode compared with the 
modeshape predicted by the FE model, for the cases of one-story structure

Figure 5.9: Graphical illustration of the modeshape components for the second mode compared with the 
modeshape predicted by the FE model, for the cases of one-story structure
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Mode #1 (111.5299Hz, zeta: 0.883%

Figure 5.10: Graphical illustration of the modeshape components for the third mode compared with the 
modeshape predicted by the FE model, for the cases of one-story structure

Figure 5.11: Graphical illustration of the modeshape components for the first mode compared with the 
modeshape predicted by the FE model, for the cases of two-story structure
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Mode #1 (15.8865 Hz, zeta: 0.463%

Figure 5.12: Graphical illustration of the modeshape components for the second mode compared with the 
modeshape predicted by the FE model, for the cases of two-story structure

Figure 5.13: Graphical illustration of the modeshape components for the third mode compared with the 
modeshape predicted by the FE model, for the cases of two-story structure
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Figure 5.14: Graphical illustration of the modeshape components for the first mode compared with the 
modeshape predicted by the FE model, for the cases of three-story structure

Figure 5.15: Graphical illustration of the modeshape components for the second mode compared with the 
modeshape predicted by the FE model, for the cases of three-story structure
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Figure 5.16: Graphical illustration of the modeshape components for the third mode compared with the 
modeshape predicted by the FE model, for the cases of three-story structure
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5.3 Application on a Metsovo bridge during construction using ambient 
vibration measurements

This section applies the developed modal identification methodologies for estimating the dynamic 
modal characteristics of a ravine bridge of Egnatia Motorway at Metsovo during construction 
using ambient vibration measurements. The operational modal analysis methodology developed 
for output-only measurements was described in Section 4.3.

5.3.1 Description of Metsovo bridge and instrumentation
The new under construction ravine bridge of Metsovo (Figure 5.17), in section 3.2 (Anthohori 
tunnel-Anilio tunnel) of Egnatia Motorway., is crossing the deep ravine of Metsovitikos river, 150 
m over the riverbed. This is the higher bridge of Egnatia Motorway., with the height of the taller 
pier M2 equal to 110 m. The total length of the bridge is 357 m. As a consequence of the strong 
inequality of the heights of the two basic piers of the bridge, M2 and M3 (110 m to 35 m), the very 
long central span of 235 m, is even longer during construction, as the pier M2 balanced 
cantlilever is 250 m long, due to the eccentrical position of the key segment. The key of the 
central span is not in midspan due to the different heights of the superstructure at its supports to 
the adjacent piers (13.0 m in pier M2 and 11.50 m in pier M3) for redistributing mass and load in 
favor of the short pier M3 and thus relaxing strong structural abnormality. The last was the main 
reason of this bridge to be designed to resist earthquakes fully elastic (q factor equal to 1).

The bridge has 4 spans, of length 44.78 m /117.87 m /235.00 m/140.00 m and three piers of 
which Ml, 45 m high, supports the boxbeam superstructure through pot bearings (movable in 
both horizontal directions), while M2, M3 piers connect monolithically to the superstructure. The 
bridge is being constructed by the balanced cantilever method of construction and according to 
the constructional phases shown in Figures 5.18 and 5.19 (November 2007). A general view of 
the bridge completed (November 2008) is shown in figure 5.20. The total width of the deck is 
13.95 m, for each carriageway. The superstructure is limited prestressed of single boxbeam 
section, of height varying from the maximum 13.5 m in its support to pier M2 to the minimum 4.00 
m in key section.
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Figure 5.18: General view of under construction Metsovo ravine bridge (November 2007)

Figure 5.19: Key of central span of under construction Metsovo ravine bridge
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Figure 5.20: General view of Metsovo ravine bridge (November 2008)

The pier M3 balanced cantilever has been instrumented after the construction of all its segments 
and before the construction of the key segment that will join with the balanced cantilever of pier 
M2 (Figure 5.19). The total length of M3 cantilever was at the time of its instrumentation 215 m 
while its total height is 35 m. Piers M2, M3 are founded on huge circular 012.0 m rock sockets in 
the steep slopes of the ravine of the Metsovitikos river, in a depth of 25 m and 15 m, 
respectively.

Six uniaxial accelerometers were installed inside the box beam cantilever M3 of the left 
carriageway of Metsovo ravine bridge. The accelerometer arrays, are shown in Figure 5.21. Due 
to the symmetry of the construction method (balanced cantilevering) and as the same number of 
segments were completed on both sides of pier M3, the instrumentation was limited to the right 
cantilever of pier M3, following two basic arrangements. According to the 1st arrangement two (2) 
sensors were supported on the head of pier M3, one measuring longitudinal and the other 
transverse accelerations (M3L, M3T), while the remaining four (4) accelerometers were 
supported on the right and the left internal sides of the box beam’s webs , two (2) distant 46m 
and two (2) distant 68m from M3 axis, respectively (LV3, RV4, LV5, RV6). All four were 
measuring vertical acceleration. According to the 2nd arrangement the last two sensors of the 1st 
arrangement were fixed in a section near the cantilever edge, distant 93m from M3 axis, while the 
other four remain in the same positions. In both arrangements the sixth sensor was adjusted to 
alternatively measure both in vertical and in transverse horizontal direction (RV6 or RT6).
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Figure 5.21: Accelerometer installation arrangements.

5.3.2 Modal identification of Metsovo bridge

The response of the cantilever structure subjected to ambient loads such as the wind, and loads 
induced by construction activities such as the crossing of light vehicles placing the prestressing 
cables inside the tendon tubes, was as expected of very low intensity (0,6% of the acceleration of 
gravity). The acceleration response time histories, measured from the 6 channel arrays, were 
analyzed using the modal identification software MITooL. All the basic modal frequencies, 
modeshapes and damping ratios of the bridge were identified.

Table 5.2: Identified modes of the Metsovo ravine bridge

No Identified Modes Hz Damping %
1 1st rotational, z axis 0.15 2.93
2 1 st longitudinal 0.30 0.18
3 1st transverse 0.62 0.43
4 2nd longitudinal 0.68 0.42
5 1st bending (deck) 0.90 0.25
6 2nd transverse 1.30 0.40
7 2nd bending (deck) 1.43 0.43
8 2nd rotational, z axis 1.46 0.47
9 3rd bending (deck) 2.28 0.40
10 3rd transverse 2.58 1.27
11 2.94 0.49
12 3.24 0.31
13 4.63 0.35
14 4.94 0.63
15 1st rotational, x axis 5.14 0.22

The identified values of the modal frequencies, the type and the corresponding values of the 
damping ratios are shown in Table 5.2. The modal damping ratios in Table 5.2, it is observed that 
the values of damping are of the order of 0.2% to 2.9%. Due to the small number of available 
sensors (six) the type of some of the modeshapes were not identified with confidence. Three 
indicative modeshapes are presented in Figure 5.22. The arrows are placed in measuring points
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and their length is proportional to the respective value of the normalized modal component. The 
accuracy in the estimation of the modal characteristics is shown in Figure 5.23 comparing the 
measured with the modal model predicted CPSD. As it is seen, the fit of the measured power 
spectral density is very good which validates the effectiveness of the proposed modal 
identification software based on ambient vibrations.

Figure 5.22: The three first identified modeshapes of Metsovo bridge.

Figure 5.23: Comparison between measured and modal model predicted CPSD.
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5.4 Application on Polymylos and Kavala bridges using ambient and 
earthquake induced vibration measurements

The last section of this applications chapter applies the developed modal identification 
methodologies for estimating the dynamic modal characteristics of two ravine bridges of Egnatia 
Motorway at Metsovo, the first at Kavala using ambient vibration measurements and the second 
at Polymylos using ambient vibration measurements and vibration measurements for the low 
level earthquake event. The operational modal analysis methodology (Output-only) for the 
ambient vibrations applied was described in section 4.3 and the modal analysis methodology for 
the earthquake induced vibrations (Multi-Input Multi-output) applied was described in section 4.4.

5.4.1 Description of bridge systems and instrumentation

Egnatia Motorway is a new, 670 km long highway, that transverses Northern Greece in an E-W 
direction. The two R/C bridges that were instrumented with special accelerometer arrays are the 
9th Ravine Bridge on the Veria - Polymylos section (Figure 5.24) and the 2nd Kavala Bypass 
Ravine Bridge (Figure 5.25). Both bridges have two, almost identical, statically independent 
branches, one for each traffic direction, one of which was instrumented in each case.

The T-shaped 9th Polymylos bridge is curved in plan and has a total length of 170 m. The deck 
cross section is a box girder of height varying parabolically from 9 m at the central pier to 4 m at 
the two abutments. It is supported monolithically by a central pier (Ml), of 35 m height, which is 
founded on a massive rectangular R/C rock socket at its basement and continues with two 
transverse flanges for the rest of its height. Each of the two 85 m long cantilever parts of the deck 
girder rests on each abutment through special elastomeric bearings that allow free sliding in the 
longitudinal direction (to accommodate thermal expansions/contractions), while functioning as 
normal elastomeric pads in the transverse (radial) direction.

Figure 5.24: View of 9th Polymylos bridge
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The 2nd Kavala Bypass Ravine Bridge, with a total length of 170 m, comprises four identical 
simply supported spans of 42.5 m, each span built with four precast post-tensioned I-beams of 
2.80m height, supporting a 26 cm thick deck, which is continuous throughout the bridge length. 
The I-beams are supported through laminated elastomeric bearings on the two abutments and 
the three piers. The piers have a 4mx4m square cross-section with 40 cm wall thickness and 
heights of 30 m (Ml, M3) and 50 m (M2). The four spans of the deck are interconnected through 
a 2 m long-20 cm thick continuity slab over the piers.

Figure 5.25: View of 2nd Kavala bridge

Two 12-channel Kinemetrics K2 ® recording units were installed on the northern branch of the 9th 
Polymylos bridge (on deck level at the middle of the total bridge deck), each supporting 12 
uniaxial Kinemetrics Episensor ® accelerometers (± 2g full scale) installed on both sides of the 
bridge deck. The recording units have a 19-bit resolution, a sampling rate capacity of up to 
200sps and a dynamic range of 108 dB @ 200 sps. Fifteen sensors were installed on the deck, 
three on the basement of the central pier and three on each of the two abutments (at the support 
level of the elastomeric bearings), as shown in Figure 5.26a. Thus, the nine sensors monitor the 
earthquake-induced excitations at the two abutments and the basement of the pier. The particular 
layout of the instrumentation permits the analysis of both ambient and earthquake-induced 
response of the bridge. The 3 to 4-letter sensor labels follow the following convention: The last 
letter denotes the orientation of the uniaxial sensor (L: longitudinal, T: transverse, V: vertical). The 
previous one denotes the side of the bridge deck on which the sensor lies (R: right, L : left). 
Finally, the first one or two letters denote the bridge section that the sensor lies on (first letters U1 
and U3 refer here to the abutment level where the elastomeric bearings are seated, U2 refers to 
the base of the central pier and all other letters refer to positions on the level of the bridge deck). 
The numbers next to each sensor label denotes the length of the cable used to connect the
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sensor to each recording unit. Among the 15 accelerometers located on the bridge deck, 8 record 
in the vertical, 1 in the longitudinal and the rest 6 in the transverse direction.

A similar, 24-accelerometer special array was used for the instrumentation of the southern branch 
of the 2nd Kavala Bypass Ravine Bridge. The two recording units were installed one at each deck 
side, at the middle of the total bridge span. The accelerometers were installed on both edges of 
the bridge deck (external sidewalk and internal New Jersey barrier). As shown in Figure 5.16b, of 
the 24 sensors, 18 were installed on the deck and 2 at the top of each of the three piers (6 in all) 
next to the elastomeric bearings so that adequate information is provided to distinguish between 
the pier and bearing stiffness. The sensor labels in Figure 5.26b follow the same convention used 
for the previous instrumentation case (Figure 5.26a): letters U1, U2 and U3 refer to the top of the 
piers, all the rest refer to positions on the deck of the bridge. The particular layout of the 
instrumentation permits the recording of the dynamic response of the bridge under ambient 
(traffic and wind) loads.

Both recording systems have common start / common trigger capabilities to enable synchronous 
data acquisition. The trigger threshold can be set independently for each sensor, and the user 
can define the sensors that will cause a system trigger. The systems are equipped with GPS 
boards as well as with external GSM/GPRS cellular modems that allowed telematic control and 
data transfer to the user offices.

45m 45m 45m 45m

(b)

Figure 5.26: Instrumentation layout of (a) Polymylos and (b) Kavala bridges
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5.4.2 Modal identification of Polymylos and Kavala bridges
Modal identification results (modal frequencies and modal damping ratios) for the Polymylos and 
Kavala bridges are shown in Table 5.3 and 5.4 for ambient vibration data of approximately 30 
minutes duration each. Also, for the Polymylos bridge, modal identification results are shown in 
Table 5.5 for a low level, magnitude ML =4.6, earthquake event that occurred on 21/2/2007

(2:04:38 GMT) at a distance 35 km Northeast of the bridge. The 20 sec earthquake recordings 
are clear and not hidden by the ambient vibrations since the latter are much smaller in amplitude 
due to the fact that the earthquake occurred after midnight, so the traffic of the bridge was scarce. 
It is noted that eight modes were successfully and reliably identified for the Polymylos bridge: five 
transverse modes and three bending modes (Table 5.3). From the earthquake vibration data, in 
addition to these modes, one more longitudinal mode was identified (Table 5.4). Representative 
measured modeshapes (1st bending and 2nd transverse) are shown in Figure 5.27 for the 
Polymylos bridge. For the Kavala bridge, seven modes were reliably estimated from the ambient 
vibration data: two transverse, one longitudinal, and four closely-spaced bending modes (Table 
5.6). The four closely-spaced modes, predicted also by the design finite element model of the 
structure, are due to the weak connection of the four spans through the 2-meter-long 20cm-thick 
continuity slabs described in Section 5.4.1.

Table 5.3: Identified modes of the 9th Polymylos bridge using ambient-induced vibration data

No Identified Modes Hz Damping %

1 1st Transverse 1.13 2.0
2 2nd Transverse 1.20 5.6
3 1st Bending (deck) 2.13 0.6
4 3rd Transverse 2.22 1.1
5 2nd Bending (deck) 3.07 0.4
6 4th Transverse 4.10 0.8
7 3rd Bending (deck) 6.66 0.5
8 5th Transverse 6.78 0.8
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Table 5.4: Identified modes of the 9th Polymylos bridge using earthquake-induced vibration data

No Identified Modes Hz Damping %
1 1st Transverse 1.29 1.8
2 1st Longitudinal 1.17 1.8
3 2nd Transverse 1.30 5.9
4 1st Bending (deck) 2.20 0.6
5 3rd Transverse 2.56 3.5
6 2nd Bending (deck) 3.20 0.7
7 4th Transverse 4.23 3.2
8 3rd Bending (deck) 6.89 0.6
9 5th Transverse 7.24 1.2

Table 5.5: Identified modes of the 2nd Kavala bridge using ambient-induced vibration data

No Identified Modes Hz Damping %

1 1st Transverse 0.81 1.4
2 1st Longitudinal 1.29 5.6
3 2nd Transverse 1.61 5.2
4 1st Bending (deck) 3.40 0.6
5 2nd Bending (deck) 3.46 0.7
6 3rd Bending (deck) 3.47 0.4
7 4th Bending (deck) 3.51 0.5

Comparing the modal damping ratios in Tables 5.3, 5.4 and 5.5, it is observed that the bending 
modes have significantly lower values of damping, of the order of 0.4% to 0.7% for the Polymylos 
and Kavala bridges, than the damping values of the lower transverse and longitudinal modes 
which are of the order of 0.8% to 5.9% for the Polymylos bridge and of the order of 1.4% to 5.6% 
for the Kavala bridge. The higher damping values observed for the lower transverse and 
longitudinal modes can be attributed to the energy dissipation arising from the higher modal 
deformation levels of the elastomeric bearings at the ends of the bridges which dominate the 
motion of these modes. Also, soil damping could also have contributed to the higher damping 
values observed for these modes.

For the Polymylos bridge, Table 5.6 compares the measured peak acceleration responses and 
the root mean square (RMS) acceleration responses for the ambient and the earthquake 
excitations. The results for only twelve out of the fifteen sensors installed on the deck are 
reported in Table 5.6 since three out of the eight sensors recording along the vertical direction 
malfunctioned during the earthquake event. Also, Table 5.6 reports the ratio between the ambient 
and the earthquake vibrations for the peak and the RMS responses for each output channel.
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Figure 5.28 gives a comparison between the ambient and the earthquake acceleration time 
histories for two representative recordings along the vertical (sensor B2RV) and the transverse 
(sensor SRT) directions.

Table 5.6: Comparison of Peak and RMS acceleration response obtained from Ambient (AV) and

Earthquake induced Vibrations (EV) for the Polymylos bridge

Peak response (cm/sec2) RMS (cm/sec2)
Channel AV EV AV/EV AV EV AV/EV

B2LV 23.2470 7.1062 3.2714 0.9181 1.9397 0.4733
M2LL 2.1767 1.0009 2.1747 0.0922 0.2407 0.3830
M2LV 11.2310 2.9575 3.7975 0.6044 0.7350 0.8223
SLV 15.9950 6.6148 2.4181 0.8847 2.0163 0.4388

T3RT 5.9160 3.3652 1.7580 0.1825 0.7129 0.2561
B2RV 26.9220 7.3206 3.6776 0.9704 1.7120 0.5668
B2RT 7.7054 2.3919 3.2215 0.2928 0.6667 0.4392
M2RT 4.3362 2.5179 1.7221 0.2582 0.6141 0.4204
A2RT 5.5674 2.5210 2.2084 0.2559 0.5911 0.4329
SRV 17.4100 12.3900 1.4052 0.9418 2.5206 0.3737
SRT 4.9252 2.5542 1.9283 0.2783 0.5786 0.4810
T1RT 1.2481 2.3865 0.5230 0.0401 0.6104 0.0657

From the Polymylos results in Tables 5.3 and 5.4, it is observed that the modal frequencies due 
to earthquake vibrations are 4% to 15% higher than the modal frequencies identified from the 
ambient vibrations. No conclusive explanation can be given for these differences without making 
assumptions about the bridge behavior within the measured vibration levels. These differences 
could be attributed to the nonlinear softening hysteretic behavior of the structural components, 
especially the elastomeric bearings. The results in Table 5.6 reveal that the peak acceleration 
responses for the earthquake induced vibrations are 1.4 to 3.8 times lower than the peak 
acceleration responses of the ambient vibrations. Accepting that the estimation of the equivalent 
modal frequencies is dominated by the peak vibration levels, this could justify a higher secant 
stiffness of the elastomeric bearings for the lower earthquake peak vibration levels which results 
in stiffer structures and thus justifies the increase in the equivalent values of the modal 
frequencies observed in Table 5.4 for earthquake induced vibrations. However, this explanation 
cannot be used to justify the higher modal frequency values observed for the modes associated 
with bending of the deck since these modes are not affected by the bearing stiffness. It is unlikely 
that similar softening nonlinear effects will arise by the deformation of the pier and deck elements 
in these low vibration levels.

To further support the above argument, the values of the modal frequencies were also identified 
using much shorter duration segments of the ambient vibrations recordings shown in Figure 5.28, 
selected so that the peak acceleration levels are approximately the same as or smaller than the 
peak acceleration of the earthquake recordings. The estimated values of the modal frequencies 
obtained by analyzing these short duration segments were found to be almost identical to the
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values of the modal frequencies that were estimated using the whole, approximate 30 minutes in 
duration, segment of the records shown in Figure 5.28. This verifies that at the low vibration 
levels considered, the aforementioned differences in the peak acceleration levels between the 
ambient and the earthquake induced vibrations cannot justify the large differences in the modal 
frequencies observed in Tables 5.3 and 5.4.

B2RV

°0 200 400 600 600 1000 1200 1400 1600 1600
sec

(a)
Sp

Figure 5.28: Accelerations time history measurements from ambient and earthquake vibrations at sensors

B2RV and SRT, (a,c) ambient, (b,d) earthquake

In contrast to the peak vibration levels, the levels of the RMS response in Table 5.6 of the 
approximately 30 minutes ambient acceleration measurements are 0.25 to 0.82 times the 
corresponding root mean square earthquake response levels. Accepting that the estimation of the 
equivalent modal frequencies in Table 5.3 is dominated by the RMS vibration levels, the modal 
frequencies due to higher RMS earthquake vibration levels are expected to decrease if softening 
of the elastomeric bearings takes place, which is not consistent with the opposite increasing trend 
observed in Table 5.4.

A more reasonable explanation that can account for the differences between Table 5.3 and Table 
5.4 is soil structure interaction effects (Safak 1995). Specifically, ignoring the rigid body rotation of 
the central pier foundation at the low vibration levels measured, the modal frequencies identified 
by the earthquake vibration measurements using as input accelerations the recordings at the 
abutments and the base of the central pier, are those of the fixed base bridge so that soil 
structure interaction effects are not participating in the identified dynamics of the bridge system. 
In contrast, the modal frequencies obtained from the ambient measurements due to excitations 
from the traffic and wind loads correspond to the dynamic characteristics of the combined system 
consisting of the bridge and accounting for soil structure interaction effects. This is also supported
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from the non-zero vibration levels recorded at the base of the piers and the top of the side 
abutments during ambient measurements. Thus, soil-structure interaction effects cause the 
combined soil-foundation-superstructure system to appear as less stiff than the superstructure 
itself, resulting in lower values of the modal frequencies which is consistent with the results 
observed in Table 5.3.

Figure 5.29 compares the measured power spectral densities with the power spectral densities 
predicted by the identified optimal modal models for selected sensors for the Polymylos bridge 
(Figure 5.29a) and the Kavala bridge (Figure 5.29b) zoomed at the frequency range near the four 
closely-spaced and overlapping modes. As it is seen, the fit of the measured power spectral 
density is very good which validates the effectiveness of the proposed modal identification 
software based on ambient vibrations. Figure 5.30 compares the Fourier transform of the 
earthquake-induced accelerations and the FT of the accelerations predicted by the optimal modal 
model for selected sensors. A very good fit is also observed, validating the effectiveness of the 
proposed modal identification software based on earthquake recordings.

(a) (b)
Figure 5.29: Comparison between measured and optimal modal model predicted power spectral densities 

for selected sensors (a) Polymylos bridge, and (b) Kavala bridge (zoomed at frequency range of four
closely-spaced modes)

(a) (b)
Figure 5.30: Comparison between measured and optimal modal model predicted Fourier transforms of the 

Polymylos earthquake accelerations recordings for selected sensors
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Chapter 6

Modal Identification Toolbox (MITooL)

6.1 Introduction

This chapter presents the software MITooL (Modal Identification Toolbox) that has been 
developed for model identification of structures and it is in the form of a user’s manual. This 
software has been developed in the System Dynamics Laboratory of the department of 
Mechanical and Industrial Engineering of University of Thessaly.

MITooL software for modal identification was originally developed in MATLAB 7.0 (R14) 
environment. The software includes Graphical User Interface (GUI) so to be simple to use and 
most comprehensible even to unspecialized persons. It allows the full exploration and analysis of 
signals that are measured on specific points on a structure when it is excited for an Experimental 
Modal Analysis (EMA), Operational Modal Analysis (OMA) or for earthquake induced vibrations, 
and it is fully adaptable to satisfy the user’s requirements by allowing the resetting of most of its 
operational parameters.

The modal identification software that has been developed comprises signal processing toolbox 
for analysing the response measurements of a structure, that are next processed using a variety 
of modal identification methodologies for the estimation of the modal characteristics. By the 
graphical interface the user first defines the signals which are time histories (usually accelerations 
and forces) measured on the structure using a sensor network and then, if a frequency relative 
methodology will be applied, he transforms them in the frequency domain setting also the 
frequency band for the identification. Next, the number of modes to be identified and their 
estimation of their modal frequencies and modal damping ratios are decided either by visual 
inspection of the response of the structure in the frequency domain, or using stabilization 
diagrams that can be computed. Lastly, after selecting the proper methodology that will be 
applied for the modal identification, the algorithm for processing the signals and estimating the 
values of the structure’s modal frequencies, modal damping ratios, modeshape components and 
modal participation factors starts by pressing a single button. The modal identification results are 
presented on the GUI and also in Matlab command window and in output files.

MITooL software was created in Matlab but its GUI is developed for users that do not posses any 
sophisticated knowledge of the Matlab environment. The only thing a MITooL software user 
needs, apart from the experience in modal identification problems for ambient and earthquake 
loads, is to know how to create and manage the .mat files in Matlab that are used for the input 
and output of the software.

This chapter is divided in two parts. The first part presents in details the operations and prospects 
of the MITooL software. In the first subsections the MITooL GUI main window is presented with 
most of the operations that can be evaluated with the software and also some information about 
the form of the compatible with the MITooL input files. The next subsections present all the 
menus of the software and all their operations are described. These operations can be divided in 
two categories, those concerning the pre-processing operations including all the configurations
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for importing the measured data in the software and for fully defining the modal identification 
problem, and those concerning the post-processing operations that include operations for 
presenting and exporting the results. The second part is a step-by-step user guide for identifying 
the modal characteristics of the Γ9 bridge at Polymylos (Greece) using real ambient vibration 
response measurements and for identifying the modal characteristics of the Γ2 bridge at Kavala 
(Greece) using vibration response measurements due to simulated earthquake loads.

6.2 MITooL Software

6.2.1 Installation notes for MITooL software

MITooL software is simply to install and use. It requires Matlab (version 7 or higher) installed in 
the computer with the folder “\MlTooL” added in the Matlab path. For example if Matlab is 
installed in folder C:\matlab7\ the folder MITooL can be copied in subfolder 
C:\MATLAB7\work\. Then in the Matlab file menu the selection Set Path... and by pressing 
Add with Subfolders pushbutton the folder C:\MATLAB7\work\MlTooL is selected. Finally, in 
Matlab Command Window the following command should be executed

» MITooL

This command opens the GUI window of the MITooL software that will be described in details in 
the next section.

73

Institutional Repository - Library & Information Centre - University of Thessaly
23/05/2023 01:59:53 EEST - 3.236.241.27



6.2.2 MITooL Graphical User Interface (GUI)
MITooL GUI main window (Figure 6.1) includes a number of menus on the upper part of the 
window that contain all the executable operations of the software. Also it contains many user 
defined input components (popup menus, radiobuttons i.e.) concerning the illustration, the 
definition of the modal identification program and the execution of the modal identification 
procedure. Some of these menus and the other components are not enabled at the beginning, 
preventing the user to execute illogical operations during the identification procedure. These 
software components are automatically enabled subsequently during the identification procedure. 
For example the pushbutton that will start the evaluation of the modal identification procedure is 
not enabled before the user completes all the necessary operations and configurations for fully 
defining the identification problem.

Active channels for the 
identification

Number of 
frequency bands

Frequency or time 
band widths 
for the
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and modal 
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Figure 6.1: Graphical User Interface of MITooL software
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6.2.2.1 Input files for MITooL

For executing the modal identification procedure of a structure with the MITooL software the data 
from the measured responses (time histories) of the structure must be properly imported in the 
software. Also the software has the capability to graphically display the structure with the sensor 
locations on it, if all the information about the structure and sensor network is properly imported in 
the software. This geometrical information about the structure can be included in the same .mat 
files with the measured responses. The .mat input file that is loaded by the MITooL software must 
contain arrays with specific names and format so that it should be compatible with the MITooL 
software. The names and format of the arrays included in this .mat input file that has to be 
created for every measurement is next described.

• accel: Double array that contains the measured time histories (accelerations by default)
of the structure. It has number of rows equal to the number of measurement 
samples and the number of columns equal to the number of sensors that are 
used for the measurement of the response and the base excitation (for the case 
of earthquake induced vibrations ).

• Ft: Double array that contains the measured force excitations. This array is needed
only for the case of experimental modal analysis where the artificial excitation 
forse is measured. It is a column array number of rows equal to the number of 
measurement samples.

• dt: Double array (scalar) that contains the time discretization of the response time
histories.

• channeltext:Cell array that contains the names of the sensors.

• ndim: Double array (scalar) that contains the number of dimensions for the graphical
display of the structure.

• FEnode: Double array that contains the number and location of nodes for the graphical
illustration of the structure as a linear mesh. The first column is the number of the 
node, the second column is the coordinate of the node in the x axis, the third 
column is the coordinate of the node in the y axis and the fourth column is the 
coordinate of the node in the z axis.

• FEelt: Double array that contains connectivity between nodes. It contains the line
element number and the nodes connected for the graphical display of the 
structure as a linear mesh. The first column is the number of the liner element, 
the second column is the number of node that the line element starts and the 
third column is the number of node that the line element ends.

• sensors: Double array that contains the number and the location of the sensors on the
structure. The first column is the number of the sensor, the second column is the 
number of the node where the sensor is located, the third column is the direction 
which the sensor can measure (1 for measuring in the x axis, 2 for measuring in 
the y axis and 3 for measuring in the z axis) and the fourth column is an 
amplitude ratio (default value must be 1 for all sensors)

Remark: The names of the arrays that are compatible with the software (accel, dt,
channeltext i.e.) can be defined to be different using the Preferences option in 
the File menu of the MITooL software.
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6.2.2.2 The File menu

The File menu (Figure 6.2) includes operations that allow the user to import data in the MITooL 
software and export data to Matlab workspace and to .mat files. From the file menu the user can 
load the measured time histories and also the data for the graphical display of the structure and 
the sensor network (Load Experimental Data & Structure) that have been described in the 
previous section. Another important operation in the File menu is the Load Session and Save 
Session operations where the user can save his current application with all its configurations and 
afterwards restore it. These operations are very important to avoid the repetition of time 
consuming operations as for example the calculation of the cross power spectral density 
functions that can be done only once and the application can be saved and then loaded many 
times and used in the modal identification problem. The Preferences operation opens a dialog 
box where the user can configure the input and output parameters of the MITooL software.
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measurements and the data 
for the graphical display of 
the structure
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with the data for the 
graphical display of

Export data to Matlab 
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Matlab workspace
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Figure 6.2: The File menu

6.2.2.3 The Preferences dialog box

The Preferences dialog box (Figure 6.3a) includes all the information the user can define so the 
input files that are loaded are compatible with MITooL software. One of the most important 
configurations in this dialog box is the definition of the identification case (Type of Identification) 
that will be evaluated. For the case of Operational Modal Analysis (OMA) the user must choose 
the Multi-Output Only radiobutton, for the case of earthquake bases modal identification the user 
must choose the Multi-Input Multi-Output radiobutton and for the case of experimental modal
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identification where one excitation force is applied and measured on the structure the user must 
choose the Single-Input Multi-Output radiobutton. All the other edit fields concern the names of 
the arrays included in the input files as they are described in Section 6.2.2.1.

-}■ Preferences ^jnjxj

r- Type of Identification: -

Modal Identification 
case (EMA, OMA or 
for earthquake 
excitations)

Names of the arrays 
included in the input 
files for the 
measurements
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C Multi-Input Multi-Output 
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In: I force

Out: 1 acceleration

i lumber oi totaSsia:

P- Data Interface Variable Names:

Names of the arrays 
included in the input files 
for the graphical display of 
the sensor network

OK Cancel Apply

Type of response 
measurements 
(displacement, 
velocity, acceleration 
or deformation)

Names of the arrays 
included in the input 
files for the graphical 
display of the structure

Figure 6.3a: The Preferences dialog box

77

Institutional Repository - Library & Information Centre - University of Thessaly
23/05/2023 01:59:53 EEST - 3.236.241.27



In Figure 6.3b. the detail about the availability of the response measurements is presented for the 
case of modal identification based on ambient vibrations. The identification of the modal 
properties can be evaluated based on available measurements of

a. acceleration
b. velocity
c. displacement
d. deformation

depending on the instrumentation available.

The user can choose from the menu the type of measurements that are available for the modal 
identification. It should be noted that for the case of using deformations for the identification, the 
estimation of the modeshape components is not possible. Instead for this case the software 
computes the derivatives of the modeshape components.

Figure 6.3b: The Preferences dialog box
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6.2.2.4 The View menu

The View menu (Figure 6.4) allows the user to define the graphical display he wants to plot on the 
MITooL software. So the graphical display of the measured signals and also the graphical display 
of the structure with the sensor network are available. From the Show panel on the lower part of 
the GUI window, the user can configure the different representations of the signals (Figures 6.5 
and 6.6).

Figure 6.4: The View menu

Figure 6.5: View Channel Mode and View All Channels Mode options

Figure 6.6: View Sensors on Structure option
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The Options menu (Figure 6.7) gives the user the access to open all the dialog boxes that 
configure all the main properties of the modal identification algorithm. These dialog boxes, which 
will be presented in details in the next sections, concern configurations about the ambient 
vibration and the earthquake induced vibration identification algorithms, about the estimation of 
the Cross Power Spectral Density (CPSD) functions and also configurations about the gradient 
based (quasi-Newton) optimization algorithm that is used for the solution of the modal 
identification problem. For quicker access to all the dialog boxes there are keyboard shortcuts.

Many of the menus and the other components of the MITooL software that are presented in the 
next subsections might not be enabled at the beginning, preventing the user to execute illogical 
operations during the identification procedure. These software components are automatically 
enabled continually during the identification procedure.

All the parameters of the MITooL software algorithms have default values at startup. Modifying 
the values of many of these parameters is recommended only to specialized users in the modal 
identification problem. Any modifications in these software parameters made by a non-expert 
user may cause problems to the evaluation of the used algorithms and consequently failure to the 
modal identification procedure.

6.2.2.5 The Options menu
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The Identification Options dialog box (Figure 6.8) is the most important dialog box for configuring 
the parameters for solving the modal identification problem. The identification algorithms estimate 
the modal parameters (modal frequencies, modal damping ratios, modeshapes and modal 
participation factors) of a modal model, based on a least squares minimization of a measure of fit 
between the measured structural response and the response that is predicted by a modal model 
in a user defined frequency band. The methodologies implemented in the software for the 
identification of the modal parameters for the cases of classically and non-classically damped 
modal models and have been discussed in details is Chapter 4.

The modal identification algorithm with the MITooL software is divided in three steps.

1. In the first step of the modal identification procedure only the modal frequencies and the 
damping ratios of the modal model of the structure are estimated in a specific, user defined, 
frequency band. By selecting the evaluation of the first step (Run Step 1) the values of the 
modal frequencies and the modal damping ratios can be chosen using the stabilization 
diagrams that are computed. Alternatively, by avoiding evaluating the first step, estimations of 
the values of the modal frequencies and the modal damping ratios can be decided by the 
user through visual inspection of the response of the structure in the frequency domain. In 
visual inspection, however, modal damping ratios are rough approximations of the estimated 
ones during the identification process.

2. In the second step of the modal identification procedure the modeshapes and the modal 
participation factors are computed given the values of the modal frequencies and the modal 
damping ratios estimated in the first step. In this step the user can decide between solving 
the problem of computing the modeshapes and the modal participation factors, which is a 
non-linear optimization problem, analytically (Step 2a, Type of Analysis: SVD of R(oj,Q), or 
using gradient based quasi-Newton computational methods for solving the nonlinear 
optimization problem (Step 2b, Type of Analysis: U(oj,(,g)). It should be noted that modal 
participation factors are not obtained when using the modal identification algorithm based on 
ambient (operational) vibrations.

3. In the third step of the modal identification procedure (Run Step 3) the values of all the modal 
parameters (modal frequencies, modal damping ratios, modeshapes and modal participation 
factors) are estimated by solving the whole non-linear optimization problem using gradient 
based quasi-Newton computational methods but applying very good initial estimations given 
in the first two steps of the algorithm.

It should be noted that for the solution of the modal identification problem using the steps 1 and 
2a the evaluation of gradient based optimization methods is avoided. These methods are iterative 
and for the solution of problems with many response signals can be very highly time consuming. 
Instead, the estimates of the modal parameters are obtained by solving linear algebraic systems 
The implementation of the third step in the identification algorithm is considered imperative for 
solving problems where is significant measurement noise in the signals and also for identifying 
closely spaced and overlapping modes. For fully comprehension of this three step algorithm for 
the modal identification problem based on ambient vibrations, a step by step example will be 
presented in the next section.

6.2.2.6 The identification Options dialog box
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Figure 6.8: The Identification Options dialog box
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The ΜΙΜΟ Options dialog box (Figure 6.9) includes the configurations of the modal identification 
algorithm for structures based on earthquake induced vibrations (measured base excitations). 
The evaluation of the modal identification algorithm estimate the modal parameters (modal 
frequencies, modal damping ratios, modeshapes and modal participation factors) of a modal 
model, based on a least squares minimization of a measure of fit between the measured 
structural response and the response that is predicted by a modal model in a user defined time 
sequent or frequency band. The MITooL software includes two modal identification 
methodologies for the case of earthquake induced vibrations (Nikolaou 2008). The first 
methodology computes the modal parameters by minimizing an error function that quantifies the 
difference between the measured responses (time histories) of the structure and the responses 
that are predicted by the modal model in the time domain. The second methodology works 
respectively but in the frequency domain, minimizing an error function that quantifies the 
difference between the Fourier transform of the measured responses of the structure and the 
Fourier transform of the responses that are predicted by the modal model. The two 
methodologies are applied for the identification of the modal parameters for the cases of 
classically and non-classically damped modal models and have been discussed in details is 
Section 4.4.

For the evaluation of the ΜΙΜΟ identification algorithm, the user must first define which of the 
measured signals correspond to base excitations (Excitation DOFs) and which of the sensors are 
active response signals(/\cf/Ve DOFs). Only the active sensors will be used in the modal 
identification procedure. Next, the user must define the modal identification methodology that will 
be used depending on the analysis domain (time or frequency) and depending on the type of 
modal model (classically or non-classically). Finally, for the case where modal sweeps will be 
used, the maximum number of modal sweeps and the modal sweep tolerance, related to 
convergence criteria for the termination of the modal sweeping procedure, should be defined. The 
selection of the modal groups for sweeping is made in the Modal Grouping dialog box (Figure 
6.10) which is opened by the Advanced pushbutton. The pushbutton All Modes groups all modes 
in one group avoiding modal sweeping.

It should be noted that for the solution of the ΜΙΜΟ modal identification problem for the case of 
earthquake induced vibrations with the frequency domain methodology, the three step algorithm 
is implemented in the software as well. The configurations of the three step algorithm are 
included in the ΜΙΜΟ Options dialog box and they are equivalent to the Identification Options 
configurations described in the previous subsection.

6.2.2.7 The ΜΙΜΟ Options dialog box
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Figure 6.10: The Modal Grouping dialog box
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The Full Spectra Options dialog box (Figure 6.11) includes the parameters of the algorithm for 
computing the cross power spectral density functions (CPSD) of the measured responses. The 
computation of the CPSD functions is required for the modal identification methodologies based 
on ambient vibrations. The efficiency of the modal identification methodologies depends highly on 
the efficiency of the evaluation of the CPSD functions. Two methodologies for the efficient 
computation of the CPSD functions are integrated in the MITooL software. These two 
methodologies have already been discussed in details in Chapter 3. With the first methodology, 
known as the correlogram approach, the CPSD functions are estimated from the Fourier 
Transform of the correlation functions of the measured signals. The second methodology is 
known as the periodogram approach or Welch method. In both methodologies the user can apply 
a window in the signals (exponential, banning i.e.) in order to reduces the effect of leakage. For 
the case of computing the positive spectra described in Chapter 3 (positive or half spectra 
approach) the same configurations can be applied as the correlogram approach for the full CPSD 
functions (full spectra).

When applying the Welch method the parameters for the efficient computation of the CPSD 
functions (Figure 6.12) must be selected properly so that the computed CPSD functions contain 
all the information for the modal characteristics to be identified without overestimating the 
response signal (adequate discretization) and avoiding the aliasing and leakage affects. The user 
must also define the number of segments that the signals will be divided and also the higher limit 
of the frequency bandwidth in which the CPSD functions will be estimated. For adequate 
discretization, an estimation for the lowest modefrequency that is expected must be applied and 
also an estimation of the magnitude of the modal damping ratios. Finally for distinguishing and 
identifying closely spaced modes, one of the most difficult issues in modal identification problems, 
the user must define an adequate frequency difference between the closely spaced modes 
expected. Many of the values of the parameters of the algorithm for computing the CPSD 
functions have default values and some others are estimated automatically by the software taking 
into account the measured signal that is to be analyzed. Any modifications to the default values of 
these parameters must be made with caution and are recommended only to users that are 
familiar with the problem of estimating the CPSD functions and signal processing techniques. Any 
modifications in these software parameters made by a non-expert user may cause problems to 
the evaluation of the used algorithms and consequently failure to the modal identification 
procedure.

6.2.2.8 The Full Spectra Options and the Half Spectra Options dialog boxes
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Figure 6.11: The Full Spectra Options dialog box
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Figure 12: The CPSD Options dialog box
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The Quasi-Newton Options dialog box (Figure 6.13) includes the parameters of the optimization 
algorithm that minimizes the error function that quantify the difference between the measured 
responses of the structure and the responses that are predicted by the modal model and is 
evaluated during the modal identification procedure for both ambient vibrations and earthquake 
induced vibrations. The minimization of the error function (objective function) with the MITooL 
software is accomplished using the fminunc and fmincon function of Matlab Optimization Toolbox 
library.

The parameters of the minimization algorithm that are available to MITooL software are those that 
define the gradient based methodology and also the convergence criteria that have to be 
accomplished for terminating the algorithm. During the evaluation of the minimization algorithm, 
the progress of the procedure can be displayed in the Matlab Command Window by selecting the 
Display: iter operation. Modifying properly the convergence parameters (TolFun and ToIX) of the 
fminunc and fmincon minimization functions greater convergence can be achieved and 
consequently better results for the modal identification problem. The parameters available in the 
Quasi-Newton Options dialog box are briefly presented below. For more details about the 
minimization functions fminunc and fmincon the user should refer to Matlab Help Manual for the 
Optimization Toolbox.

GradObj Defines if analytic expressions for the gradients of the objective function
are used (on) or not (off).

Display Defines the amount of information displayed in Matlab Command
Window during the evaluation of the minimization algorithm. The 
selections, off displays no information, iter displays information for every 
iteration of the minimization algorithm and final displays information only 
about the termination and the convergence of the algorithm.

DerivativeCheck Compares the values computed for the gradients of the objective
function using the analytical expressions with the values computed using 
finite difference scheme.

Defines the maximum number of function (objective) evaluations for the 
termination of the minimization algorithm.

Defines the maximum number of iterations for the termination of the 
minimization algorithm.

Maximum value of the gradient of the objective function that satisfy the 
convergence criterion.

Minimum value of the parameter step that satisfy the convergence 
criterion.

The analytic expression for the gradients of the objective function that are implemented in the 
MITooL software and can be used by the gradient based optimization algorithms (GradObj 
selection on) for the solution of the modal identification problem increase the number of 
calculations per function evaluation but the convergence is succeeded in less number of 
iterations, eventually reducing the total computational time especially for difficult identification 
cases.

6.2.2.9 The Quasi-Newton Options dialog box

MaxFunEvals

Maxlter

TolFun

ToIX
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Parameters of the minimization 
functions fminunc and fmirtcon of 
Matlab Optimization Toolbox

Figure 6.13: The Quasi-Newton Options dialog box

6.2.2.10 The Tools menu
The Tools menu (Figure 6.14) gives the user the access to the peripheral operations of the 
MITooL software. From this menu the user can execute directly signal processing operations and 
convert the measured signals from the time domain to the frequency domain. These operations 
include Fourier Transform of the measured signals and computation of the CPSD functions. 
These operations are executed with the selected parameters from the Options menu dialog boxes 
and have already discussed in previous subsections.

MITooL - University of Thessaly, System Dynamics Laboratory -

— Active Channels:

1 2

Tools Post Processing Window

Data Acquisition GUI, . Ctrl+D

Model Update GUI... Ctrl+G

Install Sensors,.. Ctrl+T

Execute FFT Ctrl+F

Compute FRFs Ctrl+H

Compute CPSDs Ctrl+X
- Frequency Bands

*»-

0

-20

Figure 6.14: The Tools menu
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The Post Processing menu (Figure 6.15) is enabled automatically after the modal identification 
procedure is concluded for the first time and the modal model is estimated. From this menu the 
user can illustrate on the MITooL software window the results of the modal identification 
procedure that is executed. In particular, the user can illustrate the response predicted by the 
modal model and compare it with the measured structural response (Model Identification Fits, 
Figure 6.16). Also the values of the modeshape components predicted by the modal model can 
be illustrated on the structure (Plot Modeshapes on Structure, Figure 6.17) and the values of the 
complex modeshape components for the case of non-classically damped modal model (Plot 
Modeshapes Complex Projections, Figure 6.18). Finally, an output text file can be created 
including the values for the modal frequencies, modal damping ratios, modeshape components 
and modal participation factors (View Numerical Results, Figure 6.19).

6.2.2.11 The Post Processing menu

File View Options Toolss\Post Pn 

HPiot

Processing Window 

t Model Identidfication Fits
— Identification Adjustments. plot Modeshapes on Structure'

Plot Modeshapes Complex Projections^^ 

View Numerical Results ►

Plot Stabilization Diagram ►

Active Channels:

1 2 3 4 5

Frequency Bands-

# of Frequency Bands: |l Band

□Fr equency Band f: (0.10-1.00 Hr)

Figure 6.15: The Post Processing menu
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► MllooL University of Thessaly. System Dvnanncs laboratory - Session: 16-Dec-2008. 14:37. rt06l 2007 326 10-49-23 newrframe.mat

Figure 6.16: Comparison between the response predicted by the modal model and the measured response

Figure 6.17: Graphical display of the identified modeshape components on the structure
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Figure 6.17: Graphical display of the identified complex modeshape components

f~l iinput file· 1 WordPad -101*11
File Edit View Insert Format Help

olsslHl elal Ml 1 l®IH g&I-------------------- _
______________ MODAL IDENTIFICATION RESULTS ______ 1

HodalTool Session : 1

Measure of fit : 0.00003

MODE : 1

Mode Frequency 
Damping Ratio 
Modeshape

: O.15835 Hz 
: 0.00307

-0.00441 
O . 04416 
-0.00830 
O.00834 
-O.04975 
1.OOOOO

Participation Factors :
-O.00401 
—O.28016 
-0.00326 
-O.14253 
-0.00225

MODE : 2

Mode Frequency 
Damping Ratio 
Modeshape

: 0.30453 Hz 
: 0.00184

-O.37371 
-O.00353 
O.64382 
O.64087 
1.OOOOO 
-O.04996

Participation Factors :
0.04414 
-O.00302

For Heio. oress FI
_d

1 IMJM si

Figure 6.19: Example of outpout text file
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6.2.3 The Stabilization Diagrams
The stabilization diagrams (Figure 6.20) are evaluated during the structural modal identification 
procedure based on vibration measurements and contain information about the values of the 
modal parameters. In MITooL software the evaluation of the stabilization diagrams depend on 
whether the user has selected to evaluate the first step of the three step modal identification 
algorithm, described in the previous section about the Identification Options dialog box, or not. 
The stabilization diagrams present possible values for the modal parameters as those are 
estimated analyzing the measured signals. The stabilization diagrams in MITooL software are 
evaluated taking into account the values only for the modal frequencies and modal damping 
ratios. The user can choose which of those proposed values are corresponding to the physical 
poles of the structure and ignore the values that correspond to mathematical poles that arise from 
the environmental noise on the analyzed measured signals. These selected values are used for 
the continuation of the modal identification procedure and the estimation of all the modal 
parameters. The user is also able to repeat the stabilization procedure (Re-stabilize poles) 
modifying the stabilization tolerances for the modal frequencies and the modal damping ratios 
and resulting in different stable poles.

Graphical illustration of all the physical and 
mathematical poles computed by the modal 
identification procedure with the illustration of the 
average measured response in the frequency domain

Plots the 
measured 
response in 
logarithmic 
scale

Stabilization tolerance for the 
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procedure

Stabilization tolerance for the 
modefrequencies

Repetition of the
stabilization
procedure

User selected 
values of the 
modefrequencies 
and damping 
ratios

Ignore user 
selected pole

Cancel the
identification
procedure

0 cf H

Dampng 
prance (%):

Stabilized Modes

Ignore Selected

10
Export

Abort
0.6 0.8 

Frequency (Hz)

Figure 19: The stabilization diagram
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This section presents a step-by-step guide for running the modal identification procedure using 
the MITooL software for estimating the modal properties of structures. It includes two fully 
detailed examples of modal identification procedures of bridges, the first is an application with 
real ambient vibration measurements of the G9 bridge at Polymylos (Greece) and the second is 
an application with simulated earthquake induced vibration measurements of the G2 bridge at 
Kavala (Greece).

The two structures (G9-Polymylos and G2-Kavala) have been properly instrumented and the 
measured response data (time histories) along with data for a graphical display of the structure, 
containing information about the sensor locations, have been saved to compatible with the 
MITooL software input files in the format described in previous subsection. The procedures that 
will be presented in the beginning concern the steps where the user imports (loads) in MITooL 
software the measurement data and the graphical display data. In the next steps the measured 
signals (time histories) are converted in the frequency domain (Fourier transform, computation of 
the CPSD functions respectively). Next, the time or frequency bandwidth for the modal 
identification are defined as well as the number of modes that will be estimated applying the 
proper identification algorithm. Finally, the steps that concern the post processing and the 
illustration and exporting of the modal identification results with the MITooL software will be 
presented.

6.3 Step-by-step user guide to modal identification with MITooL software

6.3.1 Modal identification application on G9 bridge at Polymylos using ambient 
vibration measurements

Step 1: Launch MITooL Software

1. MITooL folder with its subfolders must be added to Matlab path.
2. Launch the MITooL software by typing MITooL in Matlab Command Window

Software response
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1. In the File Menu select Preferences (Ctrl-P).
2. In the Preferences dialog box select Multi Output Only (default) that defines that the 

modal identification procedure that will be evaluated concern multi output only 
measurements of ambient vibrations

3. All the other edit boxes concern the name of the arrays that are included in the input file 
that will be loaded and have been presented in details in subsection.

Step 2: Multi Output Only Identification - Input File components________________________

Software response

/ MITooL - University of Thessaly, System Dynamics Labor

File View Options Took Post Processing Window

y Preferences

P- Type of Identification:

Load Experimental Data 8i Structure... Ctrl+O
Load Experimental Data... . Channel Mode -

Load Structure...
1Load Session... Ctrl+L

Save Structure...

Save Session... Ctrl+S
Save Session As... 0.5 -
Save Identification Data.,.

Import ►
Export 1

°t
/

I) Preferences... Ctrl+P
Close ^ Ctrl+W <7

TP7 ^ΊΊA

C Single Input-Multi Output 

r Multi Input-Multi Output 

(· Multi Output Only

1. Preferences 2. Multi Output
selection Only selection
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Step 3: Load Input file

1. From the File Menu select Load Experimental Data & Structure (Ctrl-O).
2. In the dialog box that popup select Multi Output Only radiobutton (already selected) and 

then OK.
3. In the dialog box Load Experimental Data Set 1 select the input .mat file with the 

measured response data and the structural geometry and sensor data. For this example 
the file G9_longitudinal_torsional_channels_0-30min.mat is loaded. This file contains 
30 minutes acceleration timehistory (200Hz sampling rate) measured by 6 sensors on the 
G9 Polymylos bridge.

Software response

> MITooL - University of Thessaly, System Dynamics Lab

File View Options Tools Post Processing Window

11 Load Experimental Data & Structure.. Ctrl+O
Load Experimental Data.., L Channel Mod

Load Structure...
Load Session... Ctrl+L 1 “
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Save Session... Ctrl+5
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Save Identification Data...

Import ►
Export ►

Preferences... Ctrl+P °t)
Close Ctrl+W 1

II 1 d Π
1 1

1. Select Load Experimental 
Data & Structure

} Experimental Modal Analysis

r- Select type of EMA: -

f~ Single-Input Multi-Output 

C Multi-Input Multi-Output (Earthquake)

(f Multi-Output Only (Ambient) Advanced Options

OK Cancel Apply

2. Select Multi Output Only
3. Input .mat 

file selection

Load Experimental Data Set 1

Look in: |__) G9
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' j matlab 
O torsional_channels_0-30min 
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File name:

Type: MATLAB MAT-file 
Date Modified: 08/08/2005 11:18 
Size: 11,2 MB

30min Open □
Files of type: MAT-files (“ mat) ~3 Cancel
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Step 4: Graphical display of measured signals and sensor network

1. In MITooL software main window select Show: 6 Channels
2. For illustrating the structure geometry and the sensor network select from the View menu 

the Sensors on Structure option.
3. For illustrating the measured signals again from the View menu select Channel Mode.

Software response
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Step 5: Computation of CPSD functions

1. From the Options Menu select Full Spectra Options (Ctrl-Q).
2. In the Full Spectra Options dialog box enter the proper values for the parameters of the 

algorithm that computes the CPSD functions as they have been described in subsection 
6.2.2.8.

3. The Compute starts the evaluation of the algorithm for the computation of the CPSD 
functions.

4. When the algorithm has finished the CPSD function are plotted on the main window. With 
the component Log in the Show panel the CPSD function are plotted in logarithmic scale.

5. From the View menu and the selection All Channel Mode or with the component All 
Channels in the Show panel all CPSD functions are plotted in the same axes.

Software response
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Options 
menu: Full 
Spectra 
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} MITooL - University of Thessaly, System Dynamics Lab
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Step 6: Identification Frequency band

1. In Show panel in MITooL main window define 0 to 8 Hz to be the frequency axes 
bandwidth by entering in the edit fields minF: 0 and maxF: 8

2. The frequency band in which the modal identification procedure will be evaluated is 
defined in the Frequency Window edit fields enter 0.6 and 1.7 Hz

3. This procedure can be done also on the window of the MITooL software by enabling the 
Drag Window button and dragging the displayed frequency band limits using the mouse 
cursor.

Software response
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Step 7: Define Modal Identification algorithm

1. From the Options Menu select Ambient ID Options (Ctrl-A).
2. In the Identification Options dialog box select the configurations of the modal 

identification options as they were described in subsection 6.2.2.6.

Software response
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Step 8: Modal identification procedure evaluation

1. Modal identification procedure starts with the Run Modal Identification pushbutton.
2. During the modal identification procedure evaluation the progress is displayed in Matlab 

Command Window.

Software response

> MITooL University ol Thessaly, System Dynamics Laboratory - Session: 17-Dec 2008, 12:26, G9_transverse_channels_0-30min.mat
Fie View Options Tools Post Processing Window

Mortification Adjustments:

- Frequency Bends - 

# of Frequency Bands: jl Band ~3

Modal Identification—

I 3
ESC

Remove 

Set Next Mode:

- Charnel Mode (Data Set 1): 
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2. Progress of the 
modal
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procedure in 
Matlab Command 
window
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Step 9: Stabilization diagram

1. In the stabilization diagram that is evaluated during the modal identification procedure the 
physical poles should be selected avoiding to select the mathematical poles.

2. To continue the modal identification procedures using the selected poles press the 
Continue button.

Software response

Remarks:

1. All poles are represented with an x.
2. Represented with □ are the poles that are “stable” with respect to the modal frequency
3. Represented with o are the poles that are “stable” with respect to the modal damping ratio
4. The poles selection is user defined using the mouse cursor.
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Βήμα 10° Post processing modal identification results

1. From the Post Processing menu select Plot Model Identification Fits to plot the 
response (CPSD function) predicted by the identified modal model.

Software response

The black line represents the response (CPSD function) predicted by the identified modal model.
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Software response

} University of Thessaly, System Dynamics Laboratory: Session_01_19/2/08
File View Options Tools Postprocessing Window

Plot Model Identification Fits I jH
j- Identification Acjustments: All Runs

Active Channels·______ Plot Modeshapes Complex Projections ► Run 1 ►

r View Numerical Results

Plot Stabilization Diagram

Frequency Bands----------------

t of Frequency Bands: [Ϊ Band 10',0.3

UNIVERSITY OF THESSALY, SYSTEM I

Run 2 > Mode 1 (1,123375 Hz)

Mode 2 (1.195429 Hz)

Step 10: Post processing modal identification results

2. To display the identified modeshape components on the structure select from the Post 
Processing menu the Ptot Modeshape on Structure selection.

fuT'··1··.·..>>.«««. ..

«•irraeancvtoai JTJSJTTTj

Mouo #2 (I 1906 HZ. 2«3
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Step 10: Post processing modal identification results

3. To create and view an output file containing all the modal identification results from the
Post Processing menu select View Numerical Results.

Software response

} MITooL - University of Thessaly, System Dynamics Laboratory - Session: 17-Dec-20

Identification Adjustments: 

r- Active Channels:-------

1 2 3 4 5

Post Processing Window

Plot Model Identidfication Fits ► ur
Plot Modeshapes on Structure ► —

Plot Modeshapes Complex Projections ►

J View Numerical Results ► 1 Run 1

Plot Stabilization Diagram ► Run 2
k A ~

-Frequency Bands-

1 1 w j-* 1Λ Ronrl - 1 1 1

ΐ3 1 «litnr I): nntotsio Modal Identification outputfilel.tKt ^jnjxj
File Edit Text Cell Tools Debug Desktop Window Help » || X

n S Μ Λ|β€)|'Β*·ίϋΙΙ| -1 in ·*· 1
1 -------------------------------------------------------------------------------
2 HODAL IDENTIFICATION RESULTS
3 -------------------------------------------------------------------------------
4 HodalTool Session : 2
5 ---------------------------------------------------------------------------------------------------------------------------

6 Measure of fit : 0.05874
7 -----------------------------------------------------------------------------------------------------------------
8 MODE : 1
9 ---------------------------------------------------------------------------------------------------------------------------

10 Mode Frequency 1.12834 Hz
11 Damping Ratio 0.02534
12 Modeshape
13 0.46658
14 0.64713
15 0.71223
16 0.92684
17 1.00000
18 0.00995
19
20 Participation Factors
21 -0.04135
22
23
24

-0.16530

25
26

MODE : 2

27 Mode Frequency 1.19558 Hz
28 Damping Ratio 0.04811
29 Hodeshape
30 1.00000
31 Q.58088
32 -0.06197
33 -0.40790
34 -0.80756
35 -0.00689
36 -I

plain text file | Ln 9 Col 12 | OVR ^
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6.3.2 Modal identification application on G2 bridge at Kavala using simulated 
earthquake induced vibration measurements

Step 1: Launch MITooL Software

1. MITooL folder with its subfolders must be added to Matlab path.
2. Launch the MITooL software by typing MITooL in Matlab Command Window

Software response
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Step 2: ΜΙΜΟ Identification - Input File components

1. In the File Menu select Preferences (Ctrl-P).
2. In the Preferences dialog box select Multi Input Multi Output radiobutton that defines 

that the modal identification procedure that will be evaluated concerns multi-input multi
output measurements of earthquake induced vibrations

3. All the other edit boxes concern the name of the arrays that are included in the input file 
that will be loaded and have been presented in details in subsection.

Software response

} MITooL - University of Thessaly, System Dynamics Labor.

File View Options Tools Postprocessing Window 

Load Experimental Data & Structure... Ctrl+O 
Load Experimental Data...

Load Structure...
Load Session... Ctrl+L

Save Structure...

Save Session... Ctrl+S

Save Session As...

Save Identification Data,.,

Import ►
Export ►

| Preferences... Ctrl+P I
Close ^ Ctrl+W

1. Preferences 
selection

2. Multi Input 
Multi Output 
radiobutton 
selection

3. Names of the 
arrays 
included in 
the input file

·} Preferences

Type of Identification: -

-=J—l2il

C Single-Input Multi-Output In:

<· MuKilnpuf Multi-Output Out | acceleration

C Multi-Output Only

Data Interface Variable Names:

Measured Response: | accel

Measured Excitation:

Time Discr elation:^.

__________________

__________________
fem

__________________
FEnode

—

^ Other Va

Sensors: 

Channel Labels: 

Number of Dimensions:

FEelt

____________

______________
sensors

_______________
channeltext ■_______________

ndim

OK Cancel Apply
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Step 3: Load Input file

1. From the File Menu select Load Experimental Data & Structure (Ctrl-O).
2. In the dialog box that popup select Multi input Multi Output radiobutton (already 

selected) and then OK.
3. In the dialog box Load Experimental Data Set 1 select the input .mat file with the 

measured response data and the structural geometry and sensor data. For this example 
the file G2_simulated_eq.mat is loaded. This file contains 46 seconds earthquake 
induced simulated acceleration time histories (200Hz sampling rate) by 6 sensors on the 
G2 Kavala bridge.
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Step 4: Graphical display of measured signals and sensor network

1. In MITooL software main window select Show: 6 Channels
2. For displaying the structure geometry and the sensor network select from the View menu 

the Sensors on Structure option.
3. For displaying the measured signals again from the View menu select Channel Mode.

2. Select 
Sensors on 
Structure

3. Select 
Channel 
Mode
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Step 5: Computing of Fourier Transform - Frequency domain

1. From the Tools Menu select Execute FFT (Ctrl-F).
2. When the Fourier transform of the signal is completed the measured responses are 

plotted in the frequency domain. With the Log radiobutton from the Show, panel the 
response can be plotted in logarithmic scale.

Software response

> MITooL - University of Thessaly, System Dynamics Labora

File View Options Tools Post Processing Window

Identification Adjus 

r- Active Channels:

1 21

Γ

Install Sensors,,.

Execute FFT
Compute FRFs 

Compute CPSDs
Frequency Bands-

Data Acquisition GUI,., Ctrl+D 

Model Update GUI,,, Ctrl+G etry Mode:

Ctrl+T

1. Evaluation of 
Fourier Transform
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Step 6: Initial estimate of the modal parameters

1. In Show panel in MITooL main window define 0 to 5 Hz is the frequency axes bandwidth 
by entering in the edit fields minF: 0 and maxF: 5

2. The frequency band in which the modal identification procedure will be evaluated is 
defined in the Frequency Window edit fields enter 0.2 and 1.6 Hz

3. Select the number of modes to be identified to be 2 modes (# of Modes to ID: 2 Modes).
4. Insert for the two modes initial estimates for the modefrequencies to be 0.49 Hz for the 

first mode and 0.53 Hz for the second mode.
5. Operations 2, 3 and can be made interactively on the MITooL software main window by 

selecting the Drag Window component.
6. Insert for the two modes initial estimates for the damping ratios to be 0.01 (1%) for both 

modes

Software response

2: U1LL

4: MIR!

(.: Mini

5. To στοιχείο 
Drag Window

4. Αρχική εκτίμηση 
της ιδισυχνότητας και 
του συντελεστή 
απόσβεσης

1. Επιλογή σε Ηζ 
minF: 0.5
maxF: 5

2. Define the 
identification 
frequency band 
Frequency Window : 
0.2 έωε 1.6 Hz

> MITooL University of Thessaly. System Dynamics Laboratory Session- 17-Dec 2008, 15:31, G9_simulated_eq.mat

DragVMndow

200 -

200

Active

3. Define the 
number of the 
identified modes
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Step 7: Define the time window

1. In MITooL main window select to show the time histories by selecting TiHi from the Show 
panel.

2. The time window in which the identification will be evaluated can be modified by enabling 
the Drag Window component and dragging the limits of the shaded time bandwidth using 
the cursor.

Software response

) MITool University of Thessaly, System Dynamics Laboratory - Session: 21-Dec-2008, 19:50, G9_KAVALA_simulated_eq.mat

Fie View Options Tools Postprocessing Window

..

r Identification Adjustments: - 

- Active Channels:-----------

r Frequency Bands 

* of Frequency Bands: [7e«nd TD

020 Frequency VMndow 

P Drag VWxiow

|l Mode |3

n

Set Next Mode

.-Show:

- Channel Mode (Data Set 1): 

5

UNIVERSITY OF THESSALY, SYSTEM DYNAMICS LABORATORY

16 Channels' minT: | 0 maxT:

(* Al Γ AcSve \ Crop Time rtstones J

1: U rn

0 5 10 15 20 25 30 35 40 45

2: U Til

0 5 10 15 20 25 30 35 40 45

3: M 1
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4: M ΤΓΠ
"w v ν v ' _1_J

0 5 10 15 20 25 30 35 40 45

5: M Rri
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6: Ml RT

1_

1. The Drag Window 
component

2.The time limits
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Step 8: Define the ΜΙΜΟ identification parameters and methodology

1. From the Options Menu select ΜΙΜΟ ID Options (Ctrl-M).
2. In the ΜΙΜΟ Identification Options dialog box enter the sensors that measure the 

response (acceleration) at the base of the structure (Excitation DOFs: 1 2).
3. Select the methodology that works in the time domain from the Analysis Domain popup 

menu and to estimate the non-classically damped model from the Type of Modal Model 
popup menu.

Software response

I. Select 
Identification 
Options from 
the Options 
menu:

/ MITooL - University of Thessaly, System Dynamics Laboratory - Ses
File View Options Tools Postprocessing Window

Ambient ID Options... Ctrl+A I
Channel Mode (Data Set 1):

r_ Active sPectra Options,., Ctrl+O 
Half Spectra Options... Ctrl-f R

Quasi-Newton Options... Ctrl+N

p Frequency Bands

IT mi

2. Enter the base 4. Advanced
excitation pushbutton that
sensors opens the Modal 

Grouping dialog box

y ΜΙΜΟ Identificatioi. Options (Earthquake excitation)

Sensor Configuration -

Excitation DOFs.

Response DORs: [

- Cases of Modal Models-------------

Analysis Domain: J Time _-J

Type of Modal Model: ^sstfy^ed J

Grouping scheme: / Al Mode/ j Advance^

Maximum Number of / yf |---------------
Sweeps: / /

Sweep Accuracy: /

3. Select the 
identification 
methodology
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Step 8: Define the ΜΙΜΟ identification parameters and methodology

1. From the Modal Grouping dialog box (Advanced pushbutton) select the default scheme 
for modal grouping (Default Scheme all for one pushbutton).

Software response

Active Group:
Modal Group 1 <3

3

Selected in Group:

ηΐΕΧΕΕΞΒΙ
iMode 2 (0.53 Hz)

Remove Selected

Available Modes:

Mode 2 (0.53 Hz)

3
Add in Group 1

333

13

3

OK l . Cancel 1 . Apply
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Step 9: Modal identification procedure evaluation

1. Modal identification procedure starts with the Run Modal Identification pushbutton.
2. During the modal identification procedure evaluation the progress is displayed in Matlab 

Command Window.

Software response

Fie View Options Took Post Processing Window

- Identification Adjustme - Channel Mode (Data Set 1 *
UNIVERSITY OF THESSALY, SYSTEM DYNAMICS LABORATORY
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Step 10: Post processing modal identification results

1. From the Post Processing menu select Plot Model Identification Fits to plot the 
response (time histories) predicted by the identified modal model.

Software response

} MITooL - University of Thessaly, System Dynamics Laboratory - Session: 21-Dec-200

File View Options Tools Post Processing Window

Identification Adjustments: 

r- Active Channels: -—-—

3 4 5 6

Plot Model Identification Fits

Plot Modeshapes on Structure

View Numerical Results

3 All Runs UNP
1 Run 1

► i—r

Plot Stabilization Diagram 
------------------------!------- --
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Step 10: Post processing modal identification results

2. The number of signals displayed in the MITooL main window is defined in the Show 
panel.

Software response

File View Options Tools Post Processing Window

P Identification A<|ustmerts: - 

Active Channels:

r Frequency Bands 

# of Frequency Bands: ] ;
020 Frequency VMndow | 160 

Γ DragVWxtow__
Modal Identification -

* of ModestoD: ^6 Modes

ΒΚΗΜΜΜΙΙ
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Remove j
Set Next Mode j 0.49 | 0Λ1

|2CtwineU ■■”n' 

Al r Active
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Step 10: Post processing modal identification results

4. To display the identified modeshape components on the structure select from the Post 
Processing menu the Plot Modeshape on Structure selection

Software response

Ρ5Ξ5-----------3
KM Kjjjtt». VW>·
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Step 10: Post processing modal identification results

To create and view an output file containing all the modal identification results from the
Post Processing menu select View Numerical Results.

Software response

} MITooL - University of Thessaly, System Dynamics Laboratory - Session: 21-De

File View Options Tools Post Processing Window

Plot Model Identification Fits
Identification Adjustments: 

r Active Channels:

r

Plot Modeshapes on Structure ►
Plot Modeshapes Complex Projections ►

EES
Fte Edfc Text Cell Tools Debug Desktop Window Help

HH
D e; IB eS M /. e

^41*1
■» * X

fflDlBflp

HODJLL IDENTIFICATION RESULTS

HodalTool Session : 2

MODE : 1

Rode Frequency 0.48453 Hz
Deanping Ratio : 0.79529 \
Hodeshape

0.04250 
0.91849 
1.00000 
0.90361

Participation Factors
0.00011
-0.06818

RODE : 2

Rode Frequency 0.51486 Hz
Damping Ratio 0.63811 %
Hodeshape

1.00000 
-0.07646 | 
-0.10092 
-0.10638

Participation Factors
0.00011
-1.00000

McttiJDmethodsjn__* pre_proces»ingFVjn__ * pfatjljn * ModafToolm * | oiipUlbd * poatprocJ4T.m * po«t_ot4xiflBJi> »

Ln 29 Col 34
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Chapter 7

Conclusions

In this thesis, the applicability of frequency and time domain identification methods in the field of 
modal analysis has been improved and generalized. The techniques developed in this thesis are 
applicable for an Experimental Modal Analysis (EMA), Operational Modal Analysis (OMA) and 
identification based on earthquake induced vibration measurements. The main objective of this 
work has been to determine the modal and other parameters of non-classically damped modal 
models used to describe the response of linear structures subjected to artificial, ambient and 
earthquake loads. The methodologies developed have been tested and implemented in a user 
friendly software.

Specifically, linear system theory is used to formulate the equations of motion that govern the 
response (displacement, velocity and acceleration) of structures. Modal analysis is used to 
describe the response at the measured (observable) degrees of freedom of the structure in terms 
of the eigenproperties (eigenvalues and eigenvectors) and the excitation. Several mathematical 
models are used to describe the vibrational behaviour of a structure with a limited number of 
parameters. These models are highly non-linear in their parameters and most identification 
algorithms do not directly identify the model parameters. Instead, the modal parameter estimation 
methods proposed identify scalar matrix fraction models, also known as common denominator 
models, left and right matrix fraction description models and state space models from the 
experimental measurements. The relation between these models and the modal parameters were 
discussed. Furthermore a distinction between continuous-time and discrete-time models was 
made.

The estimation of the power spectra between the outputs and the reference outputs is also 
discussed. The auto and cross power spectral density functions are the primary data for model 
parameter identification based on output-only (ambient) measurements. Basically, two classical 
approaches exist for the estimation of auto and cross power spectral density functions. The 
periodogram estimator operates directly on the spectra of different time blocks resulting from a 
division of the time sequences. The correlogram approach first estimates the correlation functions 
in the time-domain and next the power spectra are obtained by transferring the correlations to the 
frequency-domain. Finally, the estimation of the half (or positive) power spectra is also discussed.

The modal identification methodologies introduced are based on the minimization of an error 
function using a least squares minimization approach. The formulation was presented for the 
general case of non-classically damped modal model. It is shown how this model can be used to 
identify model parameters from both input-output measurement and from output-only 
measurements in absence of the input measurements.

For the cases of EMA and OMA the identification has been performed by analysis in the 
frequency domain. The optimal values of the modal parameters, such as modal frequencies, 
modal damping ratios, modeshapes and modal participation factors are obtained by the 
implementation of an output error methodology. In particular, estimates of the modal frequencies
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and modal damping ratios are provided by solving a system of linear algebraic equations using 
the right-matrix fraction model or the common denominator model. Stabilization diagrams are 
used to distinguish between physical and mathematical modes. This method is an extension of 
the PolyMAX or polyreference least-squares complex frequency domain method, developed by 
Peeters et al. (2004), in order to treat non-classically damped modal models describing a 
system’s response characteristics based on artificial or ambient vibration data. The estimates of 
the modeshapes and the participation factors are provided by solving a system of linear algebraic 
equations. Two different approaches have been developed for the computation of the 
modeshapes and participation factors. In the first approach the modal properties are derived 
directly by Singular Value Decomposition (SVD) of the resulting numerator matrix. In the second 
approach the advantage that the error function is quadratic with respect to the modeshapes is 
used, so the modeshapes are computed by taking stationary conditions in order to develop a 
linear system of equations from which the modeshapes are derived.

For earthquake induced vibrations, the identification has been performed by analysis in the time 
domain and in the frequency domain. The methods developed by McVerry (1980) in the 
frequency domain and Beck and Jennings (1980) in the time domain, have been extended in this 
work to treat non-classically damped modal models. Additionally, a time domain methodology for 
identifying the modal and other parameters of classically damped modal models has been also 
developed as a special case. The optimal values of the modal parameters, such as modal 
frequencies, modal damping ratios and modeshapes, were obtained by the implementation of an 
output error methodology. In time domain analysis, the optimal values were obtained by 
minimizing a measure of fit between the output measured acceleration time histories and the 
acceleration time histories predicted by a modal model. A modal sweep approach was proposed 
for which each mode was optimized separately while the contribution from the rest of the modes 
was held constant. In frequency domain analysis, the optimal values were obtained by minimizing 
a measure of fit between the theoretical Fourier transform of the model responses predicted by a 
modal model and the Fourier transform of the measured response accelerations.

A three step approach was proposed for solving the error optimization problem implemented by 
all modal identification methodologies. In the first step, the modal frequencies and modal damping 
ratios were efficiently estimated by solving a system of linear algebraic equations. Stabilization 
diagrams are used to distinguish between physical and mathematical modes. In the second step, 
the resulted values of modal frequencies and modal damping ratios from the first step were used 
for the time and the frequency domain methodologies, in order to efficiently compute the 
modeshape components and the modal participation factors by solving linear algebraic systems 
of equations. Finally, in the third step, the solution of a nonlinear optimization problem using as 
starting values for the modal properties the values that were obtained from the previous steps 
were shown to improve the modal estimates for the identification of closely spaced and 
overlapped modes. A novel aspect of this thesis is the use of the three step approach to identify 
the modes of a structure under earthquake induced vibrations.

The applicability and effectiveness the modal identification methodologies and software were 
demonstrated by applying them to a small scale laboratory structure using artificially (impulse 
hammer) excited vibration measurements and an under construction Egnatia Odos bridge at 
Metsovo (Greece) using ambient vibration measurements. For the case of the laboratory 
structure, several modes were identified and it was observed that an accurate fit resulted 
between the Frequency Response Functions predicted from the optimal modal model and the
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Frequency Response Functions computed by the measured acceleration time histories. For the 
case of Metsovo bridge fifteen modes were effectively identified but not all the types of the modes 
were confidently identified due to the small number of sensors used. An accurate fit was 
observed from the convergence of the Cross Power Spectral Density functions predicted from the 
optimal modal model to the Cross Power Spectral Density functions estimated by the measured 
accelerations. It was also observed that the estimated modal frequencies and damping ratios 
resulted from the Stabilization Diagrams were accurately identified (no major discrepancies 
between the modal frequencies and damping ratios resulted from the Stabilization Diagrams and 
the modal identification algorithm), thus validating their effectiveness.

The modal model identification methods were also applied to two representative R/C bridges of 
the Egnatia Odos at Polymylos (Greece) and at Kavala (Greece) to identify their modal properties 
for ambient and earthquake-induced vibrations. The lower transverse, longitudinal and vertical 
modes of the two bridges were indentified, including four-closely spaced and overlapping bending 
modes for the Kavala bridge. The damping values of the bending modes are of the order of 0.4% 
to 0.7% which is significantly lower than the damping values of the lower transverse and 
longitudinal modes. This is attributed to the higher damping provided mostly by the elastomeric 
bearings and the soil for the latter modes. The modal frequencies due to earthquake-induced 
vibrations are found to be 4% to 15% higher than the modal frequencies due to ambient 
vibrations. This is attributed mainly to the soil-structure interaction effects contributing to the 
dynamics of the bridge systems during excitation from wind and traffic loads. These effects are 
not present in the identified dynamics of the system based on the earthquake induced vibrations 
due to the use of the input acceleration measurements at the base of the piers and the 
abutments.

The modal model identification methods were implemented in a Graphical User Interface software 
termed Modal Identification Tool (MITooL). The software was developed in Matlab and has been 
presented in this thesis in the form of a user’s manual. All the operations and pre- and post
processing prospects of the MITooL software were presented in details. Also, a step-by-step user 
guide was provided in this thesis in order to demonstrate the use of the MITooL software. The 
user guide was demonstrated by identifying the modal characteristics of the Γ9 bridge at 
Polymylos (Greece) using real ambient vibration response measurements and by identifying the 
modal characteristics of the Γ2 bridge at Kavala (Greece) using vibration response 
measurements due to simulated earthquake loads.

The MITool developed in this thesis is useful for identifying the non-classically damped modal 
models of a variety of structures, including civil engineering structures (buildings, bridges, 
offshore structures), ground vehicle, aircrafts and various machine parts, operating under various 
load conditions. Such loading conditions include known loads that are generated by exciters and 
measured in controlled laboratory experiments, unknown ambient loads involved during the 
operation of the structure, and earthquake-induced loads that are measured using appropriately 
installed acceleration sensor network installed in the base of the civil infrastructure.

An important direction for future work is to develop modal identification software to estimate the 
modal properties of fixed base structures using ambient vibration measurements and including 
the ambient measurements at the base as input measurements in the software. This is a 
challenging problem that remains unresolved. Such theoretical development along with the 
corresponding software will allow one to identify, in the expanse of adding more sensors at the
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multiple bases of a structure, the modal properties of the fixed base buildings and bridges using 
ambient vibration measurements, while ignoring the effects of soil structure interaction.
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